AXIS 243Q Blade Video Server

User’s Manual
About This Document

This manual is intended for administrators and users of the AXIS 243Q Blade Video Server, with firmware release 4.46. The manual includes instructions for using and managing the AXIS 243Q Blade on your network. Previous experience of networking will be of use when installing and using this product. Some knowledge of UNIX or Linux-based systems would also be beneficial, for developing shell scripts and applications. Later versions of this document will be posted to the Axis Website, as required. See also the product’s online help, available via the Web-based interface.

Safety Notices Used In This Manual

Caution! - Indicates a potential hazard that can damage the product.
Important! - Indicates a hazard that can seriously impair operation. Do not proceed beyond any of the above notices until you have fully understood the implications.

Intellectual Property Rights

Axis Communications AB has intellectual property rights relating to technology embodied in the product described in this document. In particular, and without limitation, these intellectual property rights may include one or more of the patents listed at http://www.axis.com/patent.htm and one or additional patents or pending patent applications in the US and other countries. This product contains licensed third-party software. See the menu item “About” in the product’s user interface for more information.

Legal Considerations

Camera and audio surveillance can be prohibited by laws that vary from country to country. Check the laws in your local region before using this product for surveillance purposes. This product includes one (1) MPEG-4 decoder license. To purchase further licenses, contact your reseller.

Electromagnetic Compatibility (EMC)

This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to correct the interference by one or more of the following measures: Re-orient or relocate the receiving antenna; increase the separation between the equipment and receiver; connect the equipment to an outlet on a different circuit to the receiver. Consult your dealer or an experienced radio/TV technician for help. Shielded (STP) network cables must be used with this unit to ensure compliance with EMC standards.

USA – This equipment has been tested and found to comply with the limits for a Class B computing device pursuant to Subpart B of Part 15 of FCC rules, which are designed to provide reasonable protection against such interference when operated in a commercial environment. Operation of this equipment in a residential area is likely to cause interference, in which case the user at his/her own expense will be required to take measures required to correct the interference.

Europe – This digital equipment fulfills the requirements for radiated emission according to limit B of EN55022/1998, and the requirements for immunity according to EN55024/1998 residential, commercial, and light industry.


Canada – This Class B digital apparatus complies with Canadian ICES-003.

Japan – This is a class B product based on the standard of the Voluntary Control Council for Interference from Information Technology Equipment (VCCI). If this is used near a radio or television receiver in a domestic environment, it may cause radio interference. Install and use the equipment according to the instruction manual.

AXIS 243Q Blade Video Server User’s Manual
Revision 3.1
Dated: January 2009
Part No: 32637
Copyright© Axis Communications AB, 2006–2009

Liability

Every care has been taken in the preparation of this manual. Please inform your local Axis office of inaccuracies, if any. Axis Communications AB cannot be held responsible for technical or typographical errors and reserves the right to change the product and manuals without prior notice. Axis Communications AB makes no warranty of any kind with regard to the material contained within this document, including, but not limited to, the implied warranties of merchantability and fitness for a particular purpose. Axis Communications AB shall not be liable nor responsible for incidental or consequential damages in connection with the furnishing, performance or use of this material.

Trademark Acknowledgments

Ethernet, Internet Explorer, Linux, Microsoft, OS/2, UNIX, Windows, WWW are registered trademarks of the respective holders. QuickTime™ is a trademark of Apple Computer, Inc., registered in the U.S. and other countries. Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun Microsystems, Inc. in the United States and other countries. Axis Communications AB is independent of Sun Microsystems Inc. UPnP™ is a certification mark of the UPnP™ Implementers Corporation.

Support Services

Should you require technical assistance, please contact your Axis reseller. If your questions cannot be answered immediately, your reseller will forward your queries to ensure a rapid response. If you are connected to the Internet, you can download user documentation and firmware updates, find answers to resolved problems in the FAQ database, search by product, category, or phrases, report problems to Axis support staff by logging in to your private support area. Visit the Axis Support Web at www.axis.com/techsup/

Safety Notice – Battery Replacement

The AXIS 243Q Blade uses a 3.0V CR2032 Lithium battery as the power supply for its internal real-time clock (RTC). This battery will, under normal conditions, last for a minimum of 5 years. Low battery power affects the operation of the RTC, causing it to reset at every power-up. A log message will appear when battery replacement is required. The battery should not be replaced unless required! If the battery does need replacing, observe the following points:

Caution!
• Danger of Explosion if battery is incorrectly replaced
• Replace only with the same or equivalent battery, as recommended by the manufacturer.
• Dispose off used batteries according to the manufacturer’s instructions.

Trademark Acknowledgments

Ethernet, Internet Explorer, Linux, Microsoft, OS/2, UNIX, Windows, WWW are registered trademarks of the respective holders. QuickTime™ is a trademark of Apple Computer, Inc., registered in the U.S. and other countries. Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun Microsystems, Inc. in the United States and other countries. Axis Communications AB is independent of Sun Microsystems Inc. UPnP™ is a certification mark of the UPnP™ Implementers Corporation.

Safety Notice – Battery Replacement

The AXIS 243Q Blade uses a 3.0V CR2032 Lithium battery as the power supply for its internal real-time clock (RTC). This battery will, under normal conditions, last for a minimum of 5 years. Low battery power affects the operation of the RTC, causing it to reset at every power-up. A log message will appear when battery replacement is required. The battery should not be replaced unless required! If the battery does need replacing, observe the following points:

Caution!
• Danger of Explosion if battery is incorrectly replaced
• Replace only with the same or equivalent battery, as recommended by the manufacturer.
• Dispose off used batteries according to the manufacturer’s instructions.
## Contents

Product description ................................................................. 6  
  Overview .................................................................................... 6  
  LED indicators ........................................................................... 7  
  Switches & connectors ............................................................... 7  
Accessing the video server ............................................................ 9  
  Access from a browser .................................................................. 9  
  Setting the root password .......................................................... 10  
  The Live View page .................................................................... 10  
Video streams ................................................................................ 12  
  Video stream types ..................................................................... 12  
  MPEG-4 protocols and communication methods .......................... 13  
  How to stream MPEG-4 .............................................................. 13  
  AXIS Media Control (AMC) ........................................................ 14  
  Other methods of accessing the video stream ............................... 14  
  Other MPEG-4 clients ............................................................... 15  
Configuring the video server .......................................................... 16  
  Accessing the Setup link ............................................................ 16  
Video & Image ................................................................................. 17  
  Image settings ............................................................................ 17  
  Advanced - MPEG-4 settings ..................................................... 19  
  Advanced - MJPEG settings ....................................................... 21  
  Overlay/Mask ............................................................................. 21  
Live View Config ........................................................................... 23  
  Layout ......................................................................................... 23  
Pan Tilt Zoom ................................................................................ 25  
  Installing PTZ devices .............................................................. 25  
  PTZ configuration ....................................................................... 26  
  Preset positions .......................................................................... 26  
  PTZ controls ............................................................................... 27  
  Preset positions .......................................................................... 29  
  Guard tour .................................................................................. 29  
  Advanced .................................................................................... 29  
  PTZ control queue ...................................................................... 30  
  Using PTZ on video inputs 2-4 .................................................... 31  
Event configuration ......................................................................... 32  
  Event servers ............................................................................. 32  
  Event types .................................................................................. 32  
  Port status ................................................................................... 37  
System options ............................................................................... 38  
  Security ....................................................................................... 38  
  Date & time .................................................................................. 41  
Network ......................................................................................... 42
Product description

Overview
The AXIS 243Q Blade Video Server is a fully featured video server intended for security surveillance and remote monitoring needs. It is designed for mounting in the AXIS 291 Video Server Rack, which provides power and network connectivity.

The AXIS 243Q Blade video server is a four-in-one solution, which means that each physical blade unit contains four separate video servers, one for each video input. The individual video servers display as AXIS 243Q(1) Blade, AXIS 243Q(2) Blade, AXIS 243Q(3) Blade and AXIS 243Q(4) Blade. The descriptions that follow apply to all four video servers, except where otherwise indicated. Each input has its own IP address.

The four BNC inputs on AXIS 243Q Blade are for connecting analog video devices. The video server digitizes up to four analog video sources and makes them available on the network as real-time, full frame rate MPEG-4 and/or Motion JPEG video streams.

Each video input provides one alarm input and one alarm output that can be used to connect various third party devices, such as door sensors and alarm bells. The AXIS 243Q(1) Blade provides an RS-485 port for connecting to third-party PTZ systems. PTZ devices can also be used on AXIS 243Q(2) Blade, AXIS 243Q(3) Blade and AXIS 243Q(4) Blade, by creating an internal connection to these from AXIS 243Q(1) Blade.
Up to 20 viewers can access each video input on the AXIS 243Q Blade simultaneously when using Motion JPEG and MPEG-4 unicast. The number of simultaneous viewers can be increased by using multicast MPEG-4. When using AXIS Media Control (AMC) to view MPEG-4 video streams, each MPEG-4 viewer requires a separate MPEG-4 decoder license. One license is included, and further licenses can be purchased separately from your Axis dealer. If using other clients to view the MPEG-4 video stream, no further MPEG-4 decoder licenses are required.

Video can be viewed in five resolutions (up to 4CIF), and image compression is configurable. The AXIS 243Q Blade contains support for video motion detection, which allows the unit to trigger activity in the video image, and advanced scheduling tools which can also be used to trigger an event. As the AXIS 243Q Blade is designed for use in security systems, it is equipped with several security features, such as IP address filtering, user levels with passwords, and HTTPS.

Each video input on the AXIS 243Q Blade has a built-in web server, providing full access to all features through the use of a standard web browser. The built-in scripting tool allows basic applications to be created, providing basic surveillance solutions. For advanced functionality, the video server can be integrated via the use of the VAPIX® API (see www.axis.com/developer for further information).

**LED indicators**

After the startup and self-test routines are complete, the multi-colored LED indicators signal the following conditions:

<table>
<thead>
<tr>
<th>Network</th>
<th>Green</th>
<th>Steady green - no network activity</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Flashes green - network activity</td>
<td></td>
</tr>
<tr>
<td>Status</td>
<td>Green</td>
<td>Steady green - normal operation</td>
</tr>
<tr>
<td></td>
<td>Red</td>
<td>One flash - one or more units starting up</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Two flashes - a unit is resetting to factory default settings</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Steady red - hardware error on one or more units</td>
</tr>
<tr>
<td></td>
<td>Green/red</td>
<td>Flashes for no connection to AXIS Internet Dynamic DNS Service</td>
</tr>
<tr>
<td>Power</td>
<td>Green</td>
<td>Normal operation</td>
</tr>
<tr>
<td></td>
<td>Green/Ampber</td>
<td>Flashes for unit upgrade</td>
</tr>
</tbody>
</table>

**Switches & connectors**

**DIP switches** - A corresponding line termination switch is supplied for each video input. Unit, that is, with the DIP switch set in the down position.
**Control Button** - Press this button to restore the factory default settings, as described in Resetting to the factory default settings, on page 49, or to install using AXIS Internet Dynamic DNS Service (see the Installation Guide).

**Video Input** - Each video input is connected using a coax/BNC connector. Physical connections made using 75 ohm coaxial video cable have a recommended maximum length of 250 meters (800 feet).
Accessing the video server

For information on installing the video server, please refer to the Installation Guide.

The AXIS 243Q Blade can be used with most standard operating systems and web browsers. The recommended browser is Internet Explorer with Windows, and Firefox with other operating systems. See also the Technical specifications, on page 57.

**Note:** To view streaming video in Microsoft Internet Explorer, you must set your browser to allow the AXIS Media Control (AMC) to be installed on your computer. The first time an MPEG-4 video stream is accessed AMC also installs an MPEG-4 decoder for viewing the video streams. As a license is required for each instance of the decoder, the product administrator may have disabled the installation. See Viewer Settings, on page 23 for more information. If your computer restricts the use of additional software components, the camera can be configured to use a Java applet for viewing JPEG images. See the online help for more information.

**Access from a browser**

1. Start a browser (such as, Internet Explorer, Firefox).

2. Enter the IP address or host name of the video input on the AXIS 243Q Blade you wish to configure in the Location/Address field of your browser.

3. If this is the first time the camera is accessed, see Setting the root password, on page 10. Otherwise enter your user name and password, as set by the administrator.

4. The Live View page is displayed in your browser.

**Notes:** If your computer restricts the use of additional software components, the AXIS 243Q Blade can be configured to use a Java applet for viewing JPEG images. Please see the online help for more information.

When using a browser other than Microsoft Internet Explorer with AMC, instead of a stop, a snapshot and a full screen button, there is a stop and a play button in the bottom left corner of the Live view page. For a description of these buttons see The Live View page below.
Setting the root password

When accessing the camera for the first time, the Configure Root Password dialog is displayed on the screen.

1. Enter a password and re-enter to confirm the spelling. Click OK.

**Note:** Before you enter your password at this point, you can secure configuration of the root password via HTTPS by creating a self-signed certificate. To do so, click the Create self-signed certificate... button in the Create Certificate window, and then proceed as follows.

2. The Enter Network Password dialog appears. Enter the User name: root

   **Note:** The default administrator user name root is permanent and cannot be deleted or altered.

3. Enter the password as set in step 2 above, and click OK. If the password is lost, the camera must be reset to the factory default settings. See “Resetting to the factory default settings”.

If required, click Yes to install the AXIS Media Control (AMC). You will need administrator rights on the computer to do this.

The Live View page

If your AXIS 243Q Blade has been customized to meet specific requirements, the buttons and other items described below may or may not be displayed on the Live View page. The following provides an overview of each available button:

The Video Format drop-down list allows the video format on the Live View page to be temporarily changed.

The Output buttons, Pulse and Active/Inactive below, control the output directly from the Live View page. These buttons are configured under Setup > Live View Config > Layout.

**Pulse** - click this button to activate the port for a defined period of time, e.g. to switch on a light for 20 seconds.

**Active/Inactive** - click these buttons to manually start and stop a connected device, such as to switch a light on/off.

The **trigger buttons** trigger an event directly from the Live View page. These buttons are configured under Setup > Live View Config > Layout. Click these buttons to manually start and stop events.
The Snapshot button saves a snapshot of the image currently being displayed. Right-click on the video image to save it in JPEG format on your computer. This button is intended for use when the AMC viewer toolbar is not available.

The AMC viewer toolbar (AXIS Media Control) is available in Microsoft Internet Explorer only and displays the following buttons:

- The Play/Stop buttons start and stop the media stream.

- The Snapshot button saves a snapshot of the video image currently being displayed. The Snapshot function and the target directory for saving snapshots can be configured from the AMC Control Applet, in the Windows Control Panel (Internet Explorer only).

- Click the View Full Screen button and the video image will fill the entire screen area. No other windows will be visible. Press Esc (Escape) on your keyboard to cancel full screen view.

- The record button is used to record the current (MPEG-4) video stream. The location where the image file is saved can be specified using the AMC control panel. To enable recording, Select Live View Config > Layout > Viewer Settings > Enable recording button.

Note that these AMC toolbar functions can also be accessed by right-clicking in the image.

For information on using Pan/Tilt/Zoom controls, please see Pan Tilt Zoom, on page 25.
Video streams

The AXIS 243Q Blade provides several different video stream formats. You select the type depending on your requirements and on the properties of your network.

The Live View page in the AXIS 243Q Blade provides access to Motion JPEG and MPEG-4 video streams, as well as to single JPEG images. Other applications and clients can also access these video streams/images directly, without going via the Live View page.

Video stream types

Motion JPEG
This format uses standard JPEG still images in the video stream. These images are then displayed and updated at a rate sufficient to create a stream that shows constantly updated motion.

The Motion JPEG stream uses considerable amounts of bandwidth, but also provides excellent image quality, and access to every individual image contained in the stream.

Note also that multiple clients accessing Motion JPEG streams can use different image settings.

MPEG-4
This is a video compression standard that makes good use of bandwidth, and which can provide high-quality video streams at less than 1 Mbit/s.

The MPEG-4 standard provides scope for a large range of different coding tools for use by various applications in different situations, and the AXIS 243Q Blade provides certain subsets of these tools. These are represented as Video object types, which are selected for use with different viewing clients. The supported video object types are:

- Simple - sets the coding type to H.263, as used by e.g. QuickTime™.
- Advanced Simple - sets the coding type to MPEG-4 Part 2, as used by AMC (AXIS Media Control)

When using MPEG-4 it is also possible to control the bit rate, which in turn allows the control of bandwidth. CBR (Constant Bit Rate) is used to achieve a specific bit rate by varying the quality of the MPEG-4 stream. When using VBR (Variable Bit Rate), the quality of the video stream is kept as constant as possible, at the cost of a varying bit rate.

Notes:  
- MPEG-4 is licensed technology. The AXIS 243Q Blade includes one viewing client license. Installing additional unlicensed copies of the viewing client is prohibited. To purchase additional licenses, contact your Axis reseller.
- All clients viewing the MPEG-4 stream must use the same set of coding tools.
MPEG-4 protocols and communication methods

To deliver live streaming video over IP networks, various combinations of transport protocols and broadcast methods are employed.

- **RTP** (Real-Time Transport Protocol) is a protocol that allows programs to manage the real-time transmission of multimedia data, via unicast or multicast.
- **RTSP** (Real-Time Streaming Protocol) serves as a control protocol, to negotiate which transport protocol to use for the stream. RTSP is thus used by a viewing client to start a unicast session, see below.
- **UDP** (User Datagram Protocol) is a communications protocol that offers limited service for exchanging data in a network that uses the Internet Protocol (IP). UDP is an alternative to the Transmission Control Protocol (TCP). The advantage of UDP is that it is not required to deliver all data and may drop network packets when there is network congestion. This is suitable for live video, as there is no point in re-transmitting old information that will not be displayed anyway.
- **Unicasting** is communication between a single sender and a single receiver over a network. This means that the video stream goes independently to each user, and each user gets their own stream. A benefit of unicasting is that if one stream fails, it only affects one user.
- **Multicast** is bandwidth-conserving technology that reduces bandwidth usage by simultaneously delivering a single stream of information to multiple network recipients. This technology is used primarily on delimited networks (intranets), as each user needs an uninterrupted data flow and should not rely on network routers.

How to stream MPEG-4

Deciding on the combination of protocols and methods to use depends on your viewing requirements, and on the properties of your network. Setting the preferred method(s) is done in the control applet for AMC, which is found in the Windows Control Panel. When this has been set, AMC will test all the selected methods in the specified order, until the first functioning one is found.

**RTP+RTSP**

This method (actually RTP over UDP and RTSP over TCP) should be your first consideration for live video, especially when it is important to always have an up-to-date video stream, even if some images do get dropped. This can be configured as multicast or unicast.

Multicasting provides the most efficient usage of bandwidth, especially when there are large numbers of clients viewing simultaneously. Note however, that a multicast broadcast cannot pass a network router unless the router is configured to allow this. It is thus not possible to multicast over the Internet.
Unicasting should be used for video-on-demand broadcasting, so that there is no video traffic on the network until a client connects and requests the stream. However, as more and more unicast clients connect, the traffic on the network will increase and may cause congestion. Although there is a maximum of 20 unicast viewers, note that all multicast users combined count as 1 unicast viewer.

**RTP/RTSP**
This unicast method is RTP tunneled over RTSP. This can be used to exploit the fact that it is relatively simple to configure firewalls to allow RTSP traffic.

**RTP/RTSP/HTTP or RTP/RTSP/HTTPS**
These two methods can also be used to traverse firewalls. Firewalls are commonly configured to allow the HTTP protocol, thus allowing RTP to be tunneled.

**AXIS Media Control (AMC)**
The recommended method of accessing live video from the AXIS 243Q Blade is to use the AXIS Media Control (AMC) in Microsoft Internet Explorer in Windows. This ActiveX component is automatically installed on first use, after which it can be configured by opening the AMC Control Panel applet from the Windows Control Panel. Alternatively, right-click the video image in Internet Explorer.

**Other methods of accessing the video stream**
Video/images from the AXIS 243Q Blade can also be accessed in the following ways:

- If supported by the client, the AXIS 243Q Blade can use Motion JPEG server push to display video. This option maintains an open HTTP connection to the browser and sends data as and when required, for as long as required.
- As single JPEG images in a browser. Enter the path: `http://<ip>/axis-cgi/jpg/image.cgi`
  
**Note:** To specify other parameters refer to the VAPIX® API in the Developer pages at the Axis web site www.axis.com/developer.

- Windows Media Player. This requires AMC and the MPEG-4 decoder to be installed. The paths that can be used are listed below in the order of preference.
  - Unicast via RTP: `axrtpu://<ip>/mpeg4/media.amp`
  - Unicast via RTSP: `axrtsp://<ip>/mpeg4/media.amp`
  - Unicast via RTSP, tunneled via HTTP: `axrtsphttp://<ip>/mpeg4/media.amp`
  - Unicast via RTSP, tunneled via HTTPS: `axrtsphttps://<ip>/mpeg4/media.amp`
  - Multicast: `axrtpm://<ip>/mpeg4/media.amp`

**Note:** `<ip>` = IP address.
Other MPEG-4 clients

Although it may be possible to use other clients to view the MPEG-4 stream, this is not guaranteed by Axis.

For some other clients, such as, QuickTime™ the Video Object Type must be set to *Simple*. It may also be necessary to adjust the advanced MPEG-4 settings.

To assess the video stream from QuickTime™ the following path can be used:

```
rtsp://<ip>/mpeg4/media.amp
```

This path is for all supported methods, and the client will negotiate with the AXIS 243Q Blade to determine exactly which transport protocol to use.

**Note:** `<ip>` = IP address.
Configuring the video server

This section describes how to configure the AXIS 243Q Blade and is intended for administrators, who have unrestricted access to all the Setup tools.

The AXIS 243Q Blade is configured from the Setup link, in a standard web browser. For more information on supported browsers, see Technical specifications, on page 57. Note that each video input must be configured separately.

Accessing the Setup link

Follow the instructions below to access the Setup link from a web browser.

1. Start the browser and enter the IP address or host name of video input on the AXIS 243Q Blade you wish to configure in the location/address field.
2. The Live View page is now displayed. Click the Setup link. The menu that appears helps you configure your network camera.
Video & Image

The following descriptions show examples of the available features in the AXIS 243Q Blade. For details of each setting, please refer to the online help available from each page. Click 🌐 to access the online help.

Image settings

Image appearance
Modify the Image Appearance to optimize the video images according to your requirements.
All configuration of images and overlays will affect the performance of the video server, depending on usage and the available bandwidth.

- High resolution generates larger files
  Selecting the Aspect ratio correction option improves the appearance of images from analog video sources, that are displayed on computer monitors. When using MPEG-4 as video format, any aspect ratio correction for the image is applied by the viewing client (the correct aspect ratio is contained in the MPEG-4 stream).

Resolution - 4CIF de-interlacing - Showing interlaced video on a computer monitor may produce distortion when there is movement in the image. Selecting this option reduces the distortion.

- Lower compression improves image quality, but generates larger files
- Rotating the image 90 or 270 degrees will lower the maximum frame rate
- Black & White uses less bandwidth than Color

For more information on all these options, please check the online help 🍀.

Text overlay settings
Include date, time and/or text of your choice to be viewed on the image. The color of the text may be set to white or black, while background color may be set to white, black, transparent or semitransparent. The position of the text is set either to the top or the bottom of the image.

Video stream
The Maximum video stream time can be set as Unlimited, or set a maximum stream time per session in seconds, minutes or hours. When the set time has expired, a new stream on the Live View page can be started by refreshing the page in the web browser. Note that the maximum video stream time does not apply to clients connecting via multicast.

To avoid bandwidth problems on the network, the frame rate allowed to each viewer can also be limited. Select either Unlimited or define a maximum frame rate per viewer.

Test
For a preview of the image and overlay settings before saving, click Test. When you are satisfied with the settings, click Save.
**Video source settings**

These settings allow you to eliminate black borders surrounding the image, by making **Offset adjustments**. By entering values in these fields you can change the horizontal and vertical synchronization for the image. See the online help 📘 for more information.

**Advanced - MPEG-4 settings**

These are tools for adjusting the MPEG-4 settings and for controlling the video bit rate.

The MPEG-4 standard provides many different coding tools for various applications in different situations. As most MPEG-4 clients do not support all these tools, it is usual to instead define and use subsets for different clients or groups of clients. These settings allow you to define the type of client to use.

Under **Client Compatibility**, select the correct combination of **Video object type** with the **ISMA compliant** option to use for your viewing client.

The **GOV Settings** describe the composition of the MPEG-4 video stream and this format’s basic elements.

The **GOV Structure** can take two different forms; I or IP, which describe the type of images included in the video stream, as well as their internal order.

The **GOV Length** determines how many images of the one type (I or P) are sent before the next type is sent.
Adjusting the **Maximum bit rate** and setting it to **Variable** or **Constant** helps control the bandwidth used by the MPEG-4 video stream.

**Bit Rate control**
Adjusting the maximum bit rate and setting it to variable or constant is a good way of controlling the bandwidth used by the MPEG-4 video stream.

Leaving the **Maximum bit rate** as unlimited will provide consistently good image quality, but at the expense of increased bandwidth usage whenever there is more activity in the image.

Limiting the bit rate to a defined value will prevent excessive bandwidth usage, but images will be lost when the limit is exceeded.

Note that a maximum bit rate can be used for both variable and constant bit rates.

The bit rate type can be set as **Variable Bit Rate** (VBR) or **Constant Bit Rate** (CBR). VBR will adjust the bit rate according to the images’ complexity, and thus uses a lot of bandwidth for a lot of activity in the image and less when the monitored area is quiet.

When using CBR you can set a fixed **Target bit rate**, which will ensure that the level of bandwidth consumed is predictable and will not change, whatever happens in the image.

**Priority** - As the bit rate would usually need to increase for increased image activity, but cannot when CBR is selected, the frame rate and image quality will both be affected negatively. To go some of the way towards compensating for this, it is possible to prioritize either the frame rate or the image quality whenever the bit rate would normally need to be increased. Not setting a priority means the frame rate and image quality will be affected approximately equally.

**Video Stream**
This parameter can be set to frame rate to increase the frame rate by 30% in 4CIF resolution. This means that under normal conditions the maximum frame rate can be increased from 17 fps to 22 fps in PAL, and from 21 fps to 27 fps in NTSC.

Note also that depending on the amount of motion, this may also increase the required bandwidth by 1-15% for each frame.

This parameter has no effect when the resolution is set to lower than 4CIF, although there is a risk of increased bandwidth usage. In this case the parameter should be set to bandwidth.

For more information on MPEG-4 settings, refer to the online help 📞.
Advanced - MJPEG settings

Sometimes the image size may be large due to low light or complex scenery. Adjusting the Maximum frame size is a good way of controlling the bandwidth and storage used by the MJPEG video stream in these situations. Defining the frame size as Unlimited will provide consistently good image quality at the expense of increased bandwidth and storage usage during low light. Limiting the frame size helps optimize bandwidth and storage usage, but gives poor image quality. To prevent increased bandwidth and storage usage, the maximum frame size should be set to an optimal amount.

Overlay/Mask

Overlay/Mask Settings

When using an image overlay, select the Overlay/Mask Type from the following options:

- Uploaded image as overlay - usually used to provide extra information in the video image.
- Configurable areas as privacy masks - up to three black areas are used to conceal parts of the video image.

The difference between an overlay and a privacy mask is that a privacy mask cannot be bypassed by accessing the video stream with the help of the AXIS HTTP API, whereas an overlay can.

Selecting the overlay/mask type will display further settings available for the selected type. See the online help for further information.

Upload and use an overlay image

1. Select Uploaded image as overlay in the Overlay/Mask Type drop-down list. New options appear.
2. Click the Browse button by the Upload own image field and locate the image file on your computer or server.
3. Click the Upload button and follow the on-screen instructions.

To use an already uploaded image:

1. Select an uploaded image from the Use image drop-down list.
2. Place the image at the required location by entering the x and y coordinates.

Note: The x and y coordinates, and the width and height of the overlay/mask are relative to the maximum available resolution of the product.
3. Click Save.

Overlay image requirements:

<table>
<thead>
<tr>
<th>Image Formats</th>
<th>Image Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 24-bit BMP (full color)</td>
<td>The height and width of the overlay image in pixels must be exactly divisible by 4.</td>
</tr>
<tr>
<td>Windows 4-bit BMP (16 colors)</td>
<td></td>
</tr>
</tbody>
</table>

Overlay image limitations:

- The maximum overlay image size supported by the AXIS 243Q Blade is the same as the maximum image resolution. See Technical specifications, on page 57.
- When a text overlay is also used, this reduces the amount of space available to the overlay image. To keep the text readable at lower resolutions, the text overlay occupies proportionally more of the image at lower resolutions.
- If the overlay is initially positioned so that part of it is outside the video image, it will be relocated so that it appears over the video image, that is, it is always the entire image that is displayed.

Please see the online help for more information.
Live View Config

Layout
The settings on this page help determine the features to include in the Live View page, such as buttons and links.

Default Video Format
Select the default format to use on the Live View page. Checking the Show video format selection option displays a drop-down list on the Live View page allowing you to temporarily change the format.

Default Viewer
Select from the drop-down list the viewer you wish to use for your web browser. Please see the online help for more information.

Viewer Settings
Check the Show viewer toolbar option to display the viewer’s own toolbar under the image.

The Enable MPEG-4 decoder installation option helps the administrator to enable or disable the installation of the MPEG-4 decoder included with AMC. This is used to prevent the installation of unlicensed copies. Further decoder licenses can be purchased from your Axis dealer.
The **Show crosshair in PTZ joystick mode** option enables the display of a crosshair in the video image when the PTZ mode is set to joystick.

Enabling the **Use PTZ joystick mode as default** option sets the PTZ mode to joystick. The mode can be changed temporarily on the PTZ Control Panel, but will default to joystick if this is selected.

The **Enable recording button** option allows you to start an MPEG-4 recording directly from the Live View page.

**Action Buttons**

The manual trigger buttons can be used to manually start and stop an event from the Live View page. See *Event configuration*, on page 32. The snapshot button allows you to take a snapshot of the video stream and save it to a computer.

**User-defined Links**

Enter a descriptive name for the link and enter the URL in the field provided. The link appears on the Live View page.

User defined CGI links can be used to issue HTTP API requests, such as PTZ commands. For example:

1. Check **Show custom link 1**
2. Enter a descriptive name, for example, CAM1 Start PTZ.
3. Enter the cgi link:  
   http://192.168.0.125/axis-cgi/com/ptz.cgi?camera=1&continuouspantiltmove=30,-30
4. Check **Show custom link 2**.
5. Enter a descriptive name, for example, CAM1 Stop PTZ.
6. Enter the cgi link:  
   http://192.168.0.125/axis-cgi/com/ptz.cgi?camera=1&continuouspantiltmove=0,0
7. These links appear in the web interface and can be used to control the PTZ camera

For more information on the VAPIX® API, see the Developer pages at the Axis web site www.axis.com/developer. See also the section on *Pan Tilt Zoom*, on page 25.

**Output Buttons**

These buttons are used to control the outputs on the AXIS 243Q Blade and the equipment connected to them, such as switching a light on or off:

- The Pulse button activates the port for a defined period
- Active/Inactive displays two buttons, one for each action (on/off)
Pan Tilt Zoom

Installing PTZ devices
Video input 1 on the AXIS 243Q Blade supports several Pan Tilt Zoom (PTZ) devices. Please see www.axis.com for a complete list of supported devices, and to obtain the correct driver. PTZ devices can also be used on video inputs 2-4, by creating an internal connection to them from input 1. For further information see Using PTZ on video inputs 2-4, on page 31. Follow the instructions below to install a PTZ device:

1. Using an appropriate cable, connect the PTZ device to the RS-485 port, which is available via the I/O terminal connector on the AXIS 291 Video Server Rack. See I/O Terminal connector, on page 50.

2. Go to Setup link when you view your camera online, and then System Options > Ports & Devices > RS-485.

3. Select Pan Tilt Zoom from the Usage drop-down list.

4. To configure PTZ on other video inputs, enter an Authentication key to prevent unauthorized access to the RS-485 port. See Using PTZ on video inputs 2-4, on page 31.

5. Click Upload to install a PTZ driver. (PTZ drivers are available from the Axis Web site at www.axis.com)

6. Click Port Options... to modify the port settings. The default values correspond to the values specified by the PTZ driver.

7. Select the video source to use with the device.

8. If required, click the Advanced Options button to make further settings. See the online help for more details.

Note: Advanced users and application developers can also use the Axis Application Programming Interface and HTTP specification for generic control of PTZ devices using CGI commands or a TCP/IP client. Please refer to the Axis Website at www.axis.com for further information.
PTZ configuration
When PTZ has been installed for the AXIS 243Q Blade, the menu item *PTZ Configuration* appears to the left, along with sub menus.

![PTZ Configuration Menu](image)

Preset positions
Many PTZ devices provide *Preset positions*, which are pre-defined camera views that can be used to quickly move the camera to a specific location.

Under *Preset Position Setup*, use the Pan, Tilt and Zoom (PTZ) controls to steer the camera to the required position. When satisfied with the camera’s position, enter a descriptive name. The camera position, iris and focus settings are then saved as a preset position.

The position can be assumed at any time, by selecting the preset’s name from the Preset positions drop-down list. Preset positions can be selected in Live View and by events.

One position can be set as the *Home* position, which is readily accessible by clicking in the box beside *Use current position as Home*. The position’s name will then have (H) added at the end (Office Entrance (H)).
PTZ controls
If the AXIS 243Q Blade has been appropriately configured, the Live View page displays the controls available for the installed Pan Tilt Zoom (PTZ) device. The administrator can enable/disable the controls for specified users.

The exact controls shown depends on the make and model of PTZ device. The most common controls are:

- the Pan bar - moves the camera to the right and left
- the Tilt bar - tips the camera up and down
- the Zoom bar - zooms the view in and out. Note that this is only available if the camera is fitted with a zoom lens.
- the Iris bar - adjusts the brightness of the image.

Clicking on the bars themselves or on the arrows at the end of the bars will move the camera to a new position. The type of movement and the location of this new position depends on the type of PTZ driver.

When controlling the camera using a relative PTZ driver (see the bars in the illustration above) the new position is relative to the previous position, that is, left of, below, above, and so on. Clicking the bar further from the center results in a larger movement.
In contrast, when using an **absolute** driver, each position on the bar (see right) represents a defined position in the device’s range of movement, with the center of the bar representing the point midway between the two extremes of movement.

Clicking a position directly on the bar moves the camera directly to the new position in one smooth movement. Clicking on the arrows at the ends of a bar causes a stepped, incremental change.

**Using CGI links to control PTZ devices**
User-defined CGI links on the Live View page help issue HTTP API requests, for example, PTZ commands. These links are configured in the Live View Layout settings, see *The Live View page*, on page 10.

**PTZ control modes**
The PTZ device can also be controlled using **click-in-image** movement, which has two types of navigation - **Center** and **Joystick**.

The **Center** mode means that when clicking in the image, the camera view will center on the absolute position that was clicked.

The **Joystick** mode moves the camera in the direction of the mouse pointer. By clicking and holding the mouse button down in the image, the PTZ device moves the camera in that direction, relative to the center of the image. The further from the center the image is clicked, the greater the movement. The camera stops moving when the button is released.

**Note:** There is also joystick support in AXIS Media Control (AMC).

**Control panel**
The focus and iris (image brightness) can be adjusted manually by using the control bars, or they can be set for automatic adjustment, by clicking the **Auto iris** and **Auto focus** buttons.

**Note:** These buttons appear only if the PTZ driver installed supports them.

To access the **Auto iris** and **Auto focus** buttons, click the **Control panel** button. The menu to the right will then appear in the upper left hand corner of the screen.

There are also driver specific shortcuts that can appear in the Control Panel. In the screen to the right, a driver has been installed that brings up the **Wiper** shortcut button, which allows the user to configure and use a windshield wiping action with the AXIS 243Q Blade.
Preset positions
Select presets from the drop-down Source list on the Live View page. These will move
and/or zoom the camera to a pre-defined position, to cover an area of particular interest.
Events can also be configured to go to preset positions when triggered. For information on
setting up preset positions, please see Preset positions, on page 26 and the online help.

Guard tour
A guard tour moves between chosen Preset Positions, one-by-one, in a pre-determined
order or at random, and for configurable time periods. A guard tour sequence will continue
to run after the user has logged off or closed the browser.

Advanced
The Device Settings options relate to driver-specific settings; so the appearance of this
window can vary depending on the driver installed. Options that can be configured
include: Driver Specific Settings for Video Source 1, Mechanical Limits for Moving
Video Source 1, Light Control for Video Source 1, and Extended Driver Specific Settings
for Video Source 1.

The Control settings window contains tools for creating and saving short command
buttons that are located under the Control panel. These buttons provide direct access to
various built-in auxiliary commands provided by the PTZ driver and are displayed in the
PTZ Panel.

Limits - Define the pan, tilt, zoom and focus limits for the AXIS 243Q Blade. Movements
to the left and right, up and down can be restricted to narrow the area under surveillance.
The near focus limit can be set to avoid focusing on objects too close to the camera.

Note: To be able to set limits, the driver needs to be an "absolute" driver.
OSD Menu - If the PTZ unit supports an internal configuration menu, this can be accessed using the On-Screen Display (OSD). Configure the analog camera by opening and navigating through its internal menu in this display.

PTZ control queue
Use the PTZ control queue window to enable and disable PTZ queueing. This window allows you to set up a queue for viewers wanting to access the AXIS 243Q Blade, and limits the number of viewers and the length of time each viewer can access and control the PTZ unit. For more information on how to set up the control queue, please see the online help.

Note also that a viewer who belongs to a group (see Security, on page 38) with a higher PTZ priority can go before other users in the queue and take control of the AXIS 243Q Blade.
The order of priority for taking control of the queue is as follows:

1. **Administrators** - An administrator takes over PTZ control regardless of who is currently first in queue. The administrator will be removed from the queue 60 seconds after their last PTZ control command.

2. **Event** - The AXIS 243Q Blade can be set up to take control of the queue and move to a specific position for 20 seconds when triggered by an alarm. The event will immediately be placed first in the queue, except when an administrator is in control. For more information, see *Triggered Event*, on page 33.

3. **Operator** - Same as administrator, but with lower priority.

4. **Guard Tour** - A guard tour has PTZ control for an indefinite period of time. It may be overridden by; Operator, Event or administrator. Guard Tour will resume when higher priority groups leave the queue. For more information see *Guard tour*, on page 29.

5. **Viewer** - Multiple viewers must wait for their turn. The viewer has 60 seconds PTZ control before control is passed to the next viewer in queue.

**Note:** In order to identify different users in the viewer group, cookies must be enabled on the client.

### Using PTZ on video inputs 2–4

Although the AXIS 243Q Blade supports an RS-485 port on video input 1 only, it is still possible to use PTZ devices on video inputs 2-4 by creating virtual connections to these inputs from video 1 (See “RS-485 COM port” on page 52). To do this, follow these steps:

1. Configure PTZ on video input 1 and install the required PTZ driver. This step is always required, whichever video input you intend to use for PTZ, and is described in detail in *Installing PTZ devices*, on page 25. Refer also to *RS-485 COM port*, on page 52.

2. Repeat this procedure and install the same device driver on the other video input(s) you wish to use PTZ on.

3. Enter the same Authentication key as configured for video input 1. This will prevent unauthorized access to the RS-485 port.

PTZ devices on inputs 2-4 are configured in the same way as a device on video input 1. See page 26 for information on configuration.
Event configuration

This section describes how to configure the AXIS 243Q Blade for alarm handling. An event in the camera happens when certain conditions are fulfilled, and result in specific actions. The set of parameters (or conditions) that define these actions is called Event Type. For example, an alarm could be the condition, that causes the camera to act by uploading images onto a server.

This section describes how to set up event servers and event types, that is how to configure cameras to perform certain actions in response to events.

Event servers

Event Servers are used to receive uploaded image files and/or notification messages. To set up Event server connections in your camera, go to Setup > Event Configuration > Event Servers and enter the required information for the required server type.

<table>
<thead>
<tr>
<th>Server type</th>
<th>Purpose</th>
<th>Information required</th>
</tr>
</thead>
</table>
| FTP Server  | • Receives uploaded images | • Descriptive name of your choice  
|             |                     | • Network address (IP address or host name)  
|             |                     | • User name and password (for FTP server) |
| HTTP Server | • Receives notification messages  
|             | • Receives uploaded images | • Descriptive name of your choice  
|             |                     | • URL (IP address or host name)  
|             |                     | • User name and password (for HTTP server) |
| TCP Server  | • Receives notification messages | • Descriptive name of your choice  
|             |                     | • Network address (IP address or host name)  
|             |                     | • Port number |

For details on each setting, refer to the online help available from each web page.

Note: The images in pre-trigger and post-trigger buffers will be lost if the connection to the event server fails.

When the setup is complete, the connection can be tested by clicking the Test button (the test takes approximately 10 seconds).

Event types

An event type is a set of parameters describing how the video server is to perform certain actions.

Example: If somebody walks past the connected camera. If an event has been configured to act on this, the video server can record and send video images to an FTP server, or send a notification email to a pre-configured email address with a pre-configured message. Video images can be sent as an attachment with the email.
Triggered Event
A triggered event is activated by one of the following:

- a signal on an input port, from a connected push button
- detected movement in a configured motion detection window
- when the video signal is lost
- a manual action, such as, clicking the trigger button in the web interface
- on restart (reboot) after power loss
- a camera tampering alarm
- pan/tilt/zoom

How to set up a triggered event
This example describes how to set the AXIS 243Q Blade to upload images when a door is opened:

1. Click Add triggered... on the Event Types page.
2. Enter a descriptive name for the event, such as, Main door.
3. Set the priority - High, Normal or Low (see the online help).
4. Enter the minimum time interval between triggers.
5. Set the Respond to Trigger... parameters, to define when the event is to be active, for example, only after office hours.
6. Select the trigger alternative from the Triggered by... drop-down list, for example, an input port with a connected sensor if the door is opened.
7. Set the When Triggered... parameters, that is, what the video server should do if the door is opened - upload images to an FTP server.
8. Click OK to save the event in the Event Types list.

Please see the online help for descriptions of each available option.

Pre-trigger and post-trigger buffers
This function is very useful when checking to see what happened immediately before and after a trigger, for example, two minutes before and after a door is opened. Check the Upload images checkbox under Event Types > Add Triggered... > When triggered... to expand the web page with the available options.

The maximum length of time of the pre-/post-buffer depends on the selected image size and frame rate.

The Include pre-trigger buffer option refers to images stored in the server from just before the trigger. Check this option to enable the pre-trigger buffer, enter the desired length of time, and specify the required image frequency.
The **Include post-trigger buffer** option contains images from the time immediately after the trigger. Configure as for pre-trigger.

**Note:** If the pre- or post-buffer is too large for the AXIS 243Q Blade's internal memory, the frame rate is reduced and individual images may be missing. If this occurs, an entry will be created in the unit's log file.

The **Continue image upload (unbuffered)** option enables the upload of images for a fixed length of time. Specify the length of time for the uploaded recording, in seconds, minutes or hours, or for as long as the trigger is active. Finally, set the desired image frequency to the maximum (the maximum possible) or to a specified frame rate. The frame rate will be the best possible, but might not be as high as specified, especially if uploading via a slow connection.

**Scheduled event**

A **Scheduled event** can be activated at pre-set times, in a repeating pattern on selected weekdays.

**How to set up a scheduled event**

This example describes how to set the video server to send an email notification with saved images from a set time:

1. Click **Add scheduled...** on the Event Types page.
2. Enter a descriptive **name** for the event, such as Scheduled email.
3. Set the **priority** (High, Normal or Low).
4. Set the **Activation Time** parameters (24h clock) when the event should be active, for example, start on Sundays at 13.00 hours with a duration of 12 hours.
5. Set the **When Activated...** parameters which determines what the video server should do at the specified time - for example, send uploaded images to an email address.
6. Click **OK** to save the Event in the Event Types list.

Please see the online help for descriptions of each available option.
Camera tampering

The camera tampering application generates an alarm whenever the camera is repositioned, or when the lens is covered, sprayed, or severely defocused.

You must create an event, (see *How to set up a triggered event*, on page 33), for the camera to send an alarm.
Motion detection

In the Motion Detection menu, you can configure the video source(s) for motion detection. The motion detection feature is used to generate an alarm whenever movement occurs or stops in the image. The AXIS 243Q Blade can use a maximum of 10 Include/Exclude windows per video input.

- **Include** windows target specific areas within the image
- **Exclude** windows are areas to be ignored within the Include window

Once configured, the motion detection windows appear in a list when motion detection is selected to trigger an event. See *How to set up a triggered event* above.

**Note:** Using the motion detection feature may decrease overall performance in the video server.

---

**How to configure Motion Detection**

This example describes how to configure motion detection:

1. Click **Motion Detection** in the Event Config menu.
2. Click the Add Window button.
3. Select the Include or Exclude option to define an Include or Exclude window, and enter a descriptive name in the field below.
4. Adjust the size (drag the bottom right-hand corner) and position (click on the text at the top and drag to the desired position).
5. Adjust the Object Size, History and Sensitivity profile sliders (see table below for details). Any detected motion within an active window is then indicated by red peaks in the Activity window (the active window has a red frame).
6. Click Save.
Avoid triggering on small objects in the image by selecting a high size level.
To trigger motion detection as long as there is activity in the area, select a high history level.
To only detect flashing light, low sensitivity can be selected. In other cases, a high sensitivity level is recommended.

### Port status

Under Event Configuration > Port Status, there is a list that shows the status for the connected inputs and outputs of the AXIS 243Q Blade. This is for the benefit of an operator, who cannot access the System Options section.

**Example:** If the Normal state for a push button connected to an input is set to Open circuit, as long as the button is not pushed, the state is inactive. If the button is pushed, the state of the input changes to active.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Object Size</th>
<th>History</th>
<th>Sensitivity</th>
</tr>
</thead>
<tbody>
<tr>
<td>High</td>
<td>Only very large objects trigger motion detection</td>
<td>An object that appears in the region will trigger the motion detection for a long period</td>
<td>Ordinary colored objects against ordinary backgrounds will trigger the motion detection</td>
</tr>
<tr>
<td>Low</td>
<td>Even very small objects trigger motion detection</td>
<td>An object that appears in the region will trigger motion detection for only a very short period</td>
<td>Only very bright objects against a dark background will trigger motion detection</td>
</tr>
<tr>
<td>Default values</td>
<td>Low</td>
<td>Medium to High</td>
<td>Medium to High</td>
</tr>
</tbody>
</table>
System options

Security
User access control is enabled by default, when the administrator sets the root password on first access. New users are authorized with user names and passwords, or the administrator can choose to allow anonymous viewer login to the Live View page, as described below:

Users
The user list displays the authorized users and access levels:

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Viewer</td>
<td>Provides the lowest level of access, which only allows the user access to the Live View page</td>
</tr>
<tr>
<td>Operator</td>
<td>An Operator can view the Live View page, create and modify event types and adjust certain other settings. The Operator does not have access to the Systems Options configuration pages.</td>
</tr>
<tr>
<td>Administrator</td>
<td>An administrator has unrestricted access to the Setup Tools and can determine the registration of all other users.</td>
</tr>
</tbody>
</table>

User settings - check the corresponding checkboxes to enable:

- **Anonymous viewer login** - allows viewers direct access to the Live View page.
- **Anonymous PTZ control login** - allows any viewer access to the Pan Tilt Zoom controls on the Live View page (if Pan/Tilt/Zoom is available).

IP Address Filter
Checking the Enable IP address filtering box option enables the IP address filtering function. Up to 256 IP address entries may be specified (a single entry can contain multiple IP addresses). Click the Add... button to add new filtered addresses.

When the IP address filter is enabled, addresses in the list are defined as allowed or denied addresses. Other IP addresses not in this list will be allowed or denied access accordingly; if the addresses in the list are allowed, then others are denied access, and vice versa. See also the online help for more information. Users from IP addresses that are allowed must also be registered with the appropriate access rights (User, Operator or Administrator). This is done from Setup > System Options > Security > Users.

Referrals - to prevent unauthorized sources including the video stream from the AXIS 243Q Blade into external Web pages, check the Referrals option and enter the IP address or Host name of the computer hosting the Web pages with the included video stream. Multiple IP addresses/host names can be defined and are separated by semicolons (;).

Notes: If the referrals feature is enabled and you wish to also allow normal access to the Live View page, the product’s own IP address or host name must be added to the list of allowed referrers.

Restricting referrers has no effect on an MPEG-4 video stream. To restrict an MPEG-4 stream, IP address filtering must be enabled.

Restricting referrers is of greatest value when not using IP address filtering. If IP address filtering is used, then the allowed referrers are automatically restricted to those allowed IP addresses.
HTTPS
For greater security, the AXIS 243Q Blade can be configured to use HTTPS (Hypertext Transfer Protocol over SSL (Secure Socket Layer)). That is, all communication that would otherwise go via HTTP will instead go via an encrypted HTTPS connection.

Certificate - to use HTTPS for communication with the AXIS 243Q Blade, a Certificate must be created using one of these methods:

- A self-signed certificate can be created in the video server, but this does not guarantee the same level of security as an official certificate.
- An official certificate issued by a CA (Certificate Authority). A CA issues and manages security credentials and public keys for message encryption.

To create a certificate:

1. Click either Create self-signed certificate or Create Certificate Request and enter the required information in the provided fields.
2. Click OK.
3. The Create self-signed certificate option generates and installs a certificate that is displayed under Installed Certificate.
   The Create Certificate Request option generates a PEM (Privacy Enhanced Mail) formatted request which you copy and send to a CA for signing. When the signed certificate is returned, click Install signed certificate... to install the certificate in the AXIS 243Q Blade.
4. Set the HTTPS Connection Policy for the administrator, Operator and Viewer to enable HTTPS connection (set to HTTP by default).

Note: Privacy Enhanced Mail (PEM), is an early IETF proposal for securing email using public key cryptography. Please refer to the home page of your preferred CA for information on where to send the request. For more information, please see the online help.

IEEE 802.1x
IEEE 802.1x is an IEEE standard for port-based Network Admission Control. It provides authentication to devices attached to a network port (wired or wireless), establishing a point-to-point connection, or, if authentication fails, preventing access on that port. 802.1x is based on EAP (Extensible Authentication Protocol). There are many EAP methods available to access a network protected by 802.1x/EAPOL (Extensible Authentication Protocol Over Lan). The one used here is EAP-TLS (EAP-Transport Layer Security).

In a 802.1x enabled network switch, clients equipped with the correct software can be authenticated and allowed or denied network access at the Ethernet level.

Clients and servers in an 802.1x network may need to authenticate each other. In the Axis implementation this is done with the help of digital certificates provided by a Certification Authority. These are then validated by a third-party entity, such as a RADIUS server, examples of which are Free Radius and Microsoft Internet Authentication Service.
To perform the authentication, the RADIUS server uses various EAP methods/protocols. The one used in the Axis implementation is EAP-TLS (EAP-Transport Layer Security).

The AXIS network video device presents its certificate to the network switch, which in turn forwards this to the RADIUS server. The RADIUS server validates or rejects the certificate and responds to the switch, and sends its own certificate to the client for validation. The switch then allows or denies network access accordingly, on a preconfigured port.

The authentication process

1. A CA server provides the required signed certificates.
2. The Axis video device requests access to the protected network at the network switch. The switch forwards the video device’s CA certificate to the RADIUS server, which then replies to the switch.
3. The switch forwards the RADIUS server’s CA certificate to the video device, which also replies to the switch.
4. The switch keeps track of all responses to the validation requests. If all certificates are validated, the Axis video device is allowed access to the protected network via a preconfigured port.

RADIUS

RADIUS (Remote Authentication Dial In User Service) is an AAA (Authentication, Authorization and Accounting) protocol for applications such as network access or IP mobility. It is intended to work in both local and roaming situations.
CA servers

In cryptography, a Certification Authority (CA) is an entity that provides signed digital
certificates for use by other parties, and thus acts a trusted third party.

There are many commercial CAs that charge for their services. Institutions and
governments may have their own CA, and there are free CAs available.

Date & time

Current server time - displays the current date and time (24h clock). The time can be
displayed in 12h clock format in overlay images.

New server time - Select your time zone from the drop-down list and check the daylight
saving time changes, if you want.

From the Time Mode section, select the preferred method for setting the time:

- Synchronize with computer time sets the time from the clock on your computer.
- Synchronize with NTP Server - the video server will obtain the time from an
  NTP server every 60 minutes. Specify the NTP server’s IP address or host name.
- Set manually - this option allows you to manually set the time and date.

Note: If using a host name for the NTP server, a DNS server must be configured under TCP/IP settings. See Network > Advanced TCP/IP Settings below.

Date & time format used in images - specify the formats for the date and time (12h or
24h) displayed in the Live View video streams.

Use the predefined formats or use your own custom date and time formats. See File
Naming & Date/Time Formats in the online help for information on how to create
your own date and time formats.
Network

Basic TCP/IP settings

Network Settings. Click the View button to see current network settings.

IPv4 and IPv6 Address Configuration

The AXIS 243Q Blade supports both IP version 4 and IP version 6. Both versions may be enabled simultaneously, and at least one version must always be enabled.

When using IPv4, the IP address can be set automatically via DHCP, or a static IP address can be set manually.

If IPv6 is enabled, your camera will receive an IP address according to the configuration in the network router.

There are also options for setting up notification of changes in the IP address, and for using the AXIS Internet Dynamic DNS Service. For more information on setting the IP address, please see the online help 🕵️.

Notes:

- DHCP is a protocol for automatic IP address assignment on a network. IP address assignment via DHCP may lead to the situation where the IP address changes and you lose contact with the camera. Configure the options for notification of IP address change (under Services) to receive notification from the camera when the IP address changes.

Alternatively, if your DHCP server can update a DNS server, you can access the AXIS 243Q Blade by host name which is always the same, regardless of the IP address.

Services

Enable ARP/Ping setting of IP address - The IP address can be set using the ARP/Ping method, which associates the unit’s MAC address with an IP address. Check this box to enable the service. Leave disabled to prevent unintentional resetting of the IP address.

Notes:

- The ARP/Ping service is automatically disabled 2 minutes after the unit is started, or as soon as an IP address is set.
- Pinging the unit will still be possible when this service is disabled.

AXIS Internet Dynamic DNS Service - If the AXIS 243Q Blade has been registered with the Axis Internet Dynamic DNS service and the IP address for the product changes, the service is updated to reflect the change. Check the box to enable/disable automatic updates.

The domain name currently registered at the Axis Internet Dynamic DNS service for your product can at any time be removed. To do this click Settings... and follow the instructions. For more information, please refer to the online help 🕵️.
Advanced TCP/IP settings

DNS configuration
DNS (Domain Name Service) provides the translation of host names to IP addresses on your network.

Obtain DNS server address via DHCP - automatically use the DNS server settings provided by the DHCP server. Click the View button to see the current settings.

Use the following DNS server address - enter the desired DNS server by specifying the following:

Domain name - enter the domain(s) to search for the host name used by the AXIS 243Q Blade. Multiple domains can be separated by semicolons (;). The host name is always the first part of a Fully Qualified Domain Name; e.g. myserver is the host name in the Fully Qualified Domain Name myserver.mycompany.com where mycompany.com is the Domain name.

Primary DNS server and Secondary DNS server- enter the IP addresses of the primary and secondary DNS servers.

NTP configuration
Obtain NTP server address via DHCP - use a DHCP server to automatically find an NTP server to synchronize clock of the AXIS 243Q Blade with the other devices on the network

Use the following NTP server address - use the host name or IP address of a specific NTP server for time synchronization.

Host Name Configuration
The AXIS 243Q Blade can be accessed using a host name, instead of an IP address. The host name is usually the same as the assigned DNS Name. It is always the first part of a Fully Qualified Domain Name and is always one word, with no period. For example, myserver is the host name in the Fully Qualified Domain Name myserver.mycompany.com.

Enabling dynamic DNS updates allows you to alias a dynamic IP address to a static host name, allowing your computer to be more easily accessed from various locations on the Internet. Outside users can always access your server using the associated DNS name regardless of the WAN IP. The DNS server used by the user and/or the DNS server responsible for the domain in use must support RFC2136 and allow updates from the camera.

The TTL (Time To Live) value determines how long (in seconds) the reply from the DNS server should be remembered when checking that the domain name for the registered IP address is still valid.
Link-Local IPv4 address
Link-Local Address is enabled by default and assigns the network camera with an additional IP address for the UPnP protocol. The network camera can have both a Link-Local IP and a static/DHCP IP address at the same time - these will not affect each other. See **UPnP™**, on page 46.

HTTP
The default HTTP port number (80) can be changed to any port within the range 1024-65535. This is useful for simple port mapping.

HTTPS
The default HTTPS port number (443) can be changed to any port within the range 1024-65535. This is useful for simple port mapping.

NAT traversal (port mapping) for IPv4
Use NAT traversal when the AXIS 243Q Blade is located on an intranet (LAN) and you wish to make it available from the other (WAN) side of a NAT router. With NAT traversal properly configured, all HTTP traffic to an external HTTP port in the NAT router will be forwarded to the network camera.

FTP
The FTP server running in the AXIS 243Q Blade enables the upload of new firmware, user applications, and so on. Check this box option to enable the service.

RTSP
The RTSP protocol allows a connecting client to start an MPEG-4 stream. Check the box to enable the RTSP server and enter the RTSP port number to use. The default setting is 554, and the allowed port range is 1024-65535. Note that MPEG-4 streams will not be available if this is not enabled.

Network traffic
**Connection type** - The default setting is Auto-negotiate, that is, the correct speed is automatically selected. If necessary, the connection speed can be set by selecting it from the drop-down list.

**Maximum bandwidth** - Specify, in Mbit/s or kbit/s, the maximum bandwidth that the camera is allowed to use on the network. This is a useful function when connecting the camera to busy or heavily loaded networks. The default setting is **Unlimited**.

**Note:** When using MPEG-4 as the video format, remember that setting a maximum bandwidth value here may create problems for individual video streams if the maximum value is less than the sum of the bit rates set for the video streams.

For more information, please see the online help 🎧.
SOCKS
SOCKS is a networking proxy protocol. The AXIS 243Q Blade can be configured to use a SOCKS server to reach networks on the other side of a firewall/proxy server. This functionality is useful if the video server is located on a local network behind a firewall, but notifications, uploads, alarms, etc., need to be sent to a destination outside the local network (e.g. to the Internet).

QoS (Quality of service)
Quality of Service (QoS) provides the means to guarantee a certain level of a specified resource to selected traffic on a network. Quality can be defined as e.g. a maintained level of bandwidth, low latency, no packet losses, etc. The main benefits of a QoS-aware network can be summarized as:

- The ability to prioritize traffic and thus allow critical flows to be served before flows with lesser priority.
- Greater reliability in the network, thanks to the control of the amount of bandwidth an application may use, and thus control over bandwidth races between applications.

The QoS in Axis network video products marks the data packets for various types of network traffic originating from the product. This makes it possible for network routers and switches to e.g. reserve a fixed amount of bandwidth for these types of traffic. The following types of traffic are marked:

- live video
- event/alarm traffic
- management network traffic.

QoS Settings
For each type of network traffic supported by your Axis network video product, enter a DSCP (Differentiated Services Codepoint) value. This value is used to mark the traffic’s IP header. When the marked traffic reaches a network router or switch, the DSCP value in the IP header tells the router or switch which type of treatment to apply to this type of traffic, for example, how much bandwidth to reserve for it.

Note that DSCP values can be entered in decimal or hex form, but saved values are always shown in decimal.

For more information on Quality of Service, please see the Axis support web at www.axis.com/techsup

SMTP (email)
Enter the host names or addresses for your primary and secondary mail servers in the fields provided, to enable the sending of event and error email messages from the camera to predefined addresses via SMTP.
SNMP
The Simple Network Management Protocol (SNMP) allows the remote management of network devices. Select the version of SNMP to use, depending on the level of security required. Select the version of SNMP to use, by checking the appropriate box. The three levels of security are:

- SNMP V1 - includes no security
- SNMP V2c - uses very simple security, e.g. community name as password
- SNMP V3 - provides encryption and secure passwords. Use with HTTPS.

If using V1 and V2c, enter the community name for read-only access to all supported SNMP objects (except the root password and other objects that require write access). Default value = public. You can also specify the community name for read/write access to all supported SNMP objects (except read-only objects). Default value = pass.

If using HTTPS enter the password if it has not already been set. To set the password again, the AXIS 243Q Blade must be reset to the factory default settings.

UPnP™
The video server includes support for UPnP™. UPnP™ is enabled by default, and the video server then is automatically detected by operating systems and clients that support this protocol.

RTP / MPEG-4
These settings are the IP address, port number, and Time-To-Live value to use for the media stream(s) in multicast MPEG-4 format. Only certain IP addresses and port numbers should be used for multicast streams. For more information, please see the online help.

Bonjour
The AXIS 243Q Blade includes support for Bonjour. When enabled, the video server is automatically detected by operating systems and clients that support this protocol.

Ports & devices
I/O Ports - the pinout, interface support and control and monitoring functions provided by this connector are described in I/O Terminal connector, on page 50.

RS485 - The COM port on the AXIS 243Q Blade supports several operational modes. For more information, please see RS-485 COM port, on page 52.
Maintenance

- **Restart** - The video server is restarted without changing any of the settings. Use this method if the unit is not behaving as expected.
- **Restore** - The video server is restarted and most current settings are reset to factory default values. The settings that are not affected are:
  - the boot protocol (DHCP or static)
  - the static IP address
  - the default router
  - the subnet mask
  - the system time
- **Default** - The default button should be used with caution. Pressing this will return all of the video server's settings to the factory default values (including the IP address)
- **Upgrade Server** - See *Upgrading the firmware*, on page 53.
- **Backup** - Click this button to take a backup of all parameters, and any user-defined scripts. It would then be possible to return to a previous configuration if settings are changed and there is unexpected behavior.
- **Restore** - Click the Browse button to locate the saved backup file (see above) and then click the Restore button. The settings will be restored to the previous configuration.

*Note:* Backup and Restore can only be used on the same unit running the same firmware. This feature is not intended for multi-configurations or for firmware upgrades. Otherwise you can use the Axis Camera Management to download the latest firmware.

Support

**Support Overview**
The Support Overview page provides valuable information on troubleshooting and contact information, should you require technical assistance.

**System Overview**
The System Overview page provides an overview of the current network, security, event and camera settings.

**Logs & Reports**
When contacting Axis support, please be sure to provide a valid Server Report with your query. The Access Log is automatically included in the server report.

**Information**

This page gives you access to the following log files and reports that may prove useful when troubleshooting a problem or when contacting the Axis support web.

**System Log** - Provides information about system events.
Access Log - The Access Log may be used for various purposes:

- Security - Tracking all access to your the camera. The access log lists the IP addresses, users and networking protocols used to access the camera.
- Simple web attraction tracker.
- System analysis and trouble shooting.

Server Report - Information about the server status; required when requesting support.

Parameter List - Shows the unit’s parameters and their current settings.

Connection List - Lists all clients currently accessing video and audio. It is also used for system analysis and trouble shooting.

Configuration

From the drop-down lists, select the size and level of information to be added to the System and Access Log files.

Default information level for the Access Log is set to Critical & Warnings. In an error situation and when requesting support, set it to the lowest information level Critical & Warnings & Info.

For the Log Level for Email, select from the drop-down list the level of information to send as email and enter the destination email address.

Advanced

Scripting is an advanced function that provides the means for customizing and using scripts.

Caution

The scripting function is a very powerful tool. Improper use may cause unexpected behavior or even loss of contact with the unit. If a script does cause problems, reset the unit to its factory default settings (in which case, a previously saved backup file will be useful for returning the unit to its latest configuration).

Axis recommends that you do not use this function unless you fully understand its consequences. Axis support provides no assistance for customized scripts.

For more information, please visit the Developer pages at www.axis.com/developer

Plain Config - this function is for the advanced user with previous experience of configuring Axis cameras. All parameters can be set and modified from this page. Help is available via the links on the standard setup pages.

About

Third Party Software Licenses - click View Licenses for a list of the licensed software used in the AXIS 243Q Blade.
Resetting to the factory default settings

This will reset all the parameters in all 4 units (including all four IP addresses) to the factory default settings.

1. Disconnect power.
2. Press and hold the Control button and reconnect power.
3. Release the button when the Status Indicator displays red (this may take up to 15 seconds). When the Status Indicator changes to Green (may take up to 1 minute), the process is complete and the AXIS 243Q Blade has been reset.
4. Re-assign the IP addresses, using one of the methods described in this document.

To reset an individual unit to the original factory default settings, use the button provided in that unit’s web interface. For more information, please see the online help.
I/O Terminal connector

The inputs and outputs on the AXIS 243Q Blade are accessed via the 12-pin I/O terminal connector on the AXIS 291 1U Video Server Rack. The following are available:

- 4 digital transistor outputs (1 per video input)
- 4 digital inputs (1 per video input)
- RS-485 interface (AXIS 243Q(1) Blade only)
- auxiliary power and GND

The terminal connector is used in applications for motion detection, event triggering, time lapse recording, alarm notification via email, and image storage to FTP locations, among others.

- **Inputs** - used for a push button, for example. If the button is pressed, the state changes, and the input is active (shown under Event Configuration > Port Status).

- **Outputs** - an alarm device that can be activated from Output buttons on the Live View page or as an action to an Event Type. The output shows as active (in Event Configuration > Port Status), if the device is activated.

<table>
<thead>
<tr>
<th>Pin</th>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>+12V DC Power output</td>
<td>This pin can be used to power auxiliary equipment, 12V DC max 100mA per blade.</td>
</tr>
<tr>
<td>2</td>
<td>GND</td>
<td>Ground</td>
</tr>
<tr>
<td>3</td>
<td>Input 1 (Video input 1)</td>
<td>Connect to GND to activate or leave floating (or unconnected) to deactivate.</td>
</tr>
<tr>
<td>4</td>
<td>Input 2 (Video input 2)</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Input 3 (Video input 3)</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Input 4 (Video input 4)</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Output 1 (Video input 1)</td>
<td>With a maximum load of 100mA and maximum voltage of 24V DC, the output has an open-collector NPN transistor with the emitter connected to pin 2 (GND). If it is to be used with an external relay, a diode must be connected in parallel with the load for protection against any voltage transients.</td>
</tr>
<tr>
<td>8</td>
<td>Output 2 (Video input 2)</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Output 3 (Video input 3)</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Output 4 (Video input 4)</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>RS-485-A (non-inverting)</td>
<td>A half-duplex RS-485 interface for controlling auxiliary equipment, e.g. PTZ devices.</td>
</tr>
<tr>
<td>12</td>
<td>RS-485-B (inverting)</td>
<td></td>
</tr>
</tbody>
</table>

The AXIS 291 Video Server rack includes a green 12-pin connector block. Connect input/output devices to this block:

1. Loosen the corresponding screw on top of the pin on the connector block (see the table above to determine which pin to use).
2. Push the cable into the connector block and secure it by fastening the screw.
3. Once all devices are connected, connect the connector block to the video server’s terminal connector.
Schematic diagram - 1/O terminal connector

AXIS 243Q Blade - I/O Terminal connector

1. +12V Out (100mA)
2. GND
3. Relay
4. Device
5. e.g. push button

AXIS 243Q Blade
RS-485 COM port

The RS-485 COM Port supports several operational modes:

- **Generic TCP/IP** - enables the video server to receive status/data and send commands via TCP/IP
- **Generic HTTP** - enables the video server to receive status/data and send commands via HTTP
- **Pan Tilt Zoom (PTZ)** - for controlling a PTZ device. A PTZ device requires a driver for its function. Drivers can be obtained from www.axis.com. Please see page 25 for information on how to connect PTZ devices.

While the RS-485 can be used to connect a PTZ device, it is necessary that the device's protocol supports 'daisy chaining' in order to connect and control more than one camera (up to four).

Chaining the units allows them to share a single serial port. The protocol then decides which unit to address and sends commands to it specifically. The diagram below explains how the devices are connected.
Troubleshooting

Checking the firmware
Firmware is software that determines the functionality of the AXIS 243Q Blade. When troubleshooting a problem, check the current version. The latest version may contain a correction that fixes your particular problem. The current firmware version in your AXIS 243Q Blade can be seen under Setup > Basic Configuration.

Important!
Please note that the AXIS 243Q Blade uses two different firmware types at the same time. The first of these is intended for video input 1, which includes features not supported by the other inputs (2, 3, and 4). Please check that the correct firmware is loaded to the correct unit.

Upgrading the firmware
When you download firmware from the Axis Web site, your Axis product will receive the latest available functionality. Always read the upgrade instructions and release notes available with each new release, before updating the firmware. New firmware can be downloaded to the AXIS 243Q Blade over the network.

Note: Pre-configured and customized settings will be retained after the new firmware is installed (provided the features are available in the new firmware) although this is not guaranteed by Axis Communications.

1. Save the firmware file to your computer. The latest versions of the firmware files for the AXIS 243Q Blade are available free of charge from the Axis Web site at www.axis.com/techsup
2. Go to Setup > System Options > Maintenance in the video server’s Web pages.
3. In the Upgrade Server section and browse to the desired firmware file on your computer. Click Upgrade.

Notes: Always read the upgrade instructions available with each new release, before updating the firmware.

After starting the process, you should always wait at least 20 minutes before restarting the AXIS 243Q Blade, even if you suspect the procedure has failed.

Your dealer reserves the right to charge for any repair attributable to faulty updating by the user.
Emergency recovery procedure

If power or the network connection to the AXIS 243Q Blade is lost during the upgrade, the process will fail and the unit will become unresponsive. A red Status LED indicates a failed upgrade. To recover the unit, follow the steps below. The serial number can be found on the label supplied with the product.

1. **UNIX/Linux** - From the command line, type the following:
   
   ```
   arp -s <IP address of AXIS 243Q Blade> <serial number> temp
   ping -s 408 <IP address of AXIS 243Q Blade>
   ```

   **Windows** - From a command/DOS prompt, type the following:
   
   ```
   arp -s <IP address of AXIS 243Q Blade> <Serial number>
   ping -l 408 -t <IP address of AXIS 243Q Blade>
   ```

2. If the unit does not reply within a few seconds, restart it and wait for a reply. Press CTRL+C to stop Ping.

3. Open a web browser and type in the AXIS 243Q Blade’s IP address. In the page that appears, use the **Browse** button to select the upgrade file to use, e.g. `axis243q.bin`. Then click the **Load** button to restart the upgrade process.

4. After the upgrade has completed (1-10 minutes), the unit will automatically restart and show a steady green on the Power and Status LEDs, and a green flash on the Network LED.

5. Reinstall the AXIS 243Q Blade.

If the emergency recovery procedure does not get the AXIS 243Q Blade up and running again, please contact Axis support at [www.axis.com/techsup/](http://www.axis.com/techsup/)

Support

If you contact Axis support, please help us help you resolve your problems expediently by providing a server report, log file and a brief description of the problem.

**Server Report** - Click the link provided on the page at **Setup > System Options > Support > Support Overview**. The report contains important information about the server and its software, as well as a list of the current parameters.

**Log file** - Go to **Setup > System Options > Support > Logs & Reports**. The Log file records events within the unit since the last restart of the system and can prove a useful diagnostic tool for troubleshooting.
# Symptoms, Possible Causes and Remedial Actions

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause</th>
<th>Remedial Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Problems setting the IP address</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Using ARP/Ping</td>
<td>IP address must be set within two minutes after power has been applied to the video server. Restart the server and try again. Ensure also the ping length is set to 408. (See the AXIS 243Q Blade Installation Guide).</td>
<td></td>
</tr>
<tr>
<td>The video server is located on a different subnet</td>
<td>If the IP address intended for the AXIS 243Q Blade and the IP address of your computer are located on different subnets, you will not be able to set the IP address. Contact your network administrator for an IP address on the same subnet as the computer you are performing the installation from.</td>
<td></td>
</tr>
</tbody>
</table>
| The IP address is being used by another device | Disconnect power from the AXIS 243Q Blade. Run the Ping command (in a Command/DOS window, type `ping <IP address of unit>`

If you receive: Reply from `<IP address>`: bytes = 32; time = 10 ms...... - this means that the IP address may already be in use by another device on your network. You must obtain a new IP address and reinstall the unit.

If you receive: Request timed out - this means that the IP address is available for use with your video server. In this case, check all cabling and reinstall the unit. | |
| **The AXIS 243Q Blade cannot be accessed from a web browser** | | |
| Cannot log in | If the AXIS 243Q Blade has been configured to use HTTPS, check that the protocol in the URL used to access the unit is correct. You may need to type this in manually (http or https) in the browser’s address field. | |
| The IP address has been changed by DHCP | 1) Move the AXIS 243Q Blade to an isolated network or to one with no DHCP or BOOTP server. Set the IP address again, using the ARP Ping command.

2) Access the unit and disable BOOTP and DHCP in the TCP/IP settings. Return the unit to the main network. The unit now has a fixed IP address that will not change.

3) As an alternative to 2), if dynamic IP address via DHCP or BOOTP is required, select the required service and then configure IP address change notification from the network settings. Return the unit to the main network. The unit will now have a dynamic IP address, but will notify you if the address changes. | |
<p>| Other networking problems | Test the network cable by connecting it to another network device, then Ping that device from your workstation. See instructions above. | |
| <strong>Cannot send notifications, uploads, alarms, to a destination outside the local network</strong> | | |
| Firewall protection | The video server can be configured to use a SOCKS server to reach networks on the other side of a firewall/proxy server. | |
| Your AXIS 243Q Blade is accessible locally, but not externally | | |
| Firewall protection | Check the Internet firewall with your system administrator. | |
| Default routers required | Check if you need to configure the default router settings. | |
| The Internet site is too heavily loaded | Use a script on your web server to relay images from the AXIS 243Q Blade to the Internet. | |
| <strong>The Status indicator shows red and the server is inaccessible</strong> | | |
| A firmware upgrade has been interrupted or the firmware has been damaged in some other way | A rescue firmware is running in the product. First, set the IP address using AXIS IP utility or ARP and Ping, (See the AXIS 243Q Blade Installation Guide). Then, using a web browser, access the unit and download the latest firmware to the product, see <a href="#">Upgrading the firmware</a>, on page 53. | |
| <strong>No images displayed in the Web interface</strong> | | |
| Problem with AMC (Internet Explorer only) | To enable the updating of images in Microsoft Internet Explorer, set your browser to allow ActiveX controls. Also, make sure that AXIS Media Control (AMC) component is installed on your workstation. | |
| Installation of additional ActiveX component restricted or prohibited | Configure your AXIS 243Q Blade to use a Java applet for updating the images under Live View Config &gt; Layout &gt; Default Viewer for Internet Explorer. See the online help for more information. | |
| <strong>Video Image Problems</strong> | | |</p>
<table>
<thead>
<tr>
<th><strong>Image too dark or too light</strong></th>
<th>Check that the termination dip switch for the video source is set to the correct position. See also the online help on Video Source Settings.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Black borders around the video image</strong></td>
<td>Adjust the X and/or Y offset, in the Video Source Settings. See the online help for information.</td>
</tr>
<tr>
<td><strong>Problems uploading own files</strong></td>
<td>There is only limited space available for the upload of your own files. Try deleting one or more existing files, to free up space.</td>
</tr>
<tr>
<td><strong>Missing images in uploads</strong></td>
<td>This can occur when trying to use a larger image buffer than is actually available. Try lowering the frame rate or the upload period.</td>
</tr>
<tr>
<td><strong>Slow image update</strong></td>
<td>Configuring pre-buffers, motion detection, high resolution images, and high frame rates, will reduce the performance of the video server.</td>
</tr>
<tr>
<td><strong>Slow performance</strong></td>
<td>Slow performance may be caused by heavy network traffic, multiple users accessing the unit, low performance clients, and features such as Motion Detection, Event handling, Image rotation.</td>
</tr>
</tbody>
</table>
| **Bad snapshot images** | ![Table of Bad Snapshot Images]

**Display incorrectly configured on your workstation**
In Display Properties, configure your display to show at least 65000 colors, i.e. at least 16-bit.
Using only 16 or 256 colors on your display will produce dithering artifacts in the image.

**Incorrect exposure in images**
If the AXIS 243Q Blade is to be connected in loopthrough with other equipment, disable the input termination by turning the corresponding DIP switch to OFF.

**Problems with the MPEG-4 format**

| **Lower frame rate than expected** | Check with the administrator that there is enough bandwidth available. Check also the settings for bit rate control, in the Video & Image > Advanced > MPEG-4 settings. Using an inappropriate video object type can also affect the frame rate. See the online help for more information. Check in the AMC control panel applet (MPEG-4 tab) that video processing is not set to Decode only I frames. Lower the image resolution. Reduce the number of applications running on the client computer. |
| **No MPEG-4 displayed in the client** | Check that the correct network interface is selected in the AMC control panel applet (network tab). Check that the relevant MPEG-4 connection methods are enabled in the AMC control panel applet (network tab). In the AMC control panel, select the MPEG-4 tab and click the button Set to default MPEG-4 decoder. |
| **No multicast MPEG-4 displayed in the client** | Check with your network administrator that the multicast addresses used by the AXIS 243Q Blade are valid for your network. Check with your network administrator to see if there is a firewall preventing viewing. |
| **Multicast MPEG-4 only accessible by local clients** | Check if your router supports multicasting, or if the router settings between the client and the server need to be configured. The TTL (Time To Live) value may need to be increased. |
| **Poor rendering of MPEG-4 images** | Color depth set incorrectly on clients. Set to 16-bit or 32-bit color. If text overlays are blurred, or if there are other rendering problems, you may need to enable Advanced Video Rendering. This is done on the MPEG-4 tab in the AMC control panel applet. Ensure that your graphics card is using the latest device driver. The latest drivers can usually be downloaded from the manufacturer’s web site. |
| **Color saturation is different in MPEG-4 and Motion JPEG** | Modify the settings for your graphics adapter. Please see the adapter’s documentation for more information. |

For further assistance, please contact your reseller or check the product's support pages on the Axis Website at www.axis.com/techsup
## Technical specifications

<table>
<thead>
<tr>
<th>Item</th>
<th>Specification</th>
</tr>
</thead>
</table>
| **Model**                 | • AXIS 243Q Blade Video Server  
                           | • Requires the AXIS 291 1U Video Server Rack                                                                                              |
| **Video compression**     | • Motion JPEG  
                           | • MPEG-4 Part 2 (ISO/IEC 14496-2), Profiles: ASP and SP                                                                                   |
| **Resolutions**           | • 4CIF, 2CIFExp, 2CIF, CIF, QCIF  
                           | • Max 704x480 (NTSC), 704x576 (PAL)  
                           | • Min 176x120 (NTSC), 176x144 (PAL)                                                                                                        |
| **Frame rate**            | • Up to 30/25 per channel in all resolutions (Motion JPEG or MPEG-4)  
                           |                                                                                                                                            |
| (NTSC/PAL)                |                                                                                                                                            |
| **Video streaming**       | • Simultaneous Motion JPEG and MPEG-4  
                           | • Controllable frame rate and bandwidth  
                           | • Constant and variable bit rate (MPEG-4)                                                                                                 |
| **Image settings**        | • Compression levels: 11 (Motion JPEG) /23 (MPEG-4)  
                           | • Rotation: 90°, 180°, 270°  
                           | • Aspect ratio correction  
                           | • Color: color, black & white  
                           | • Overlay capabilities: time, date, text, image, privacy mask  
                           | • De-interlace filter                                                                                                                      |
| **Pan/Tilt/Zoom**         | • A wide range of analog PTZ dome cameras is supported, drivers available free of charge at www.axis.com  
                           | • 20 presets/camera  
                           | • Guard tour  
                           | • PTZ control queue  
                           | • Supports Windows compatible joysticks                                                                                                    |
| **Security**              | • Multiple user access levels with password protection  
                           | • IP address filtering  
                           | • HTTPS encryption  
                           | • IEEE 802.1X authentication                                                                                                               |
| **Alarm and event**       | • Events triggered by video motion detection, tampering detection, external input, PTZ presets, product restart, video loss, or according to a schedule  
                           | • Image upload over FTP, email, HTTP  
                           | • Notification over TCP, email, HTTP and external output  
                           | • 9 MB of pre- and post alarm buffer/channel (approx. 4 min of CIF resolution video at 4 fps)                                              |
| management                |                                                                                                                                            |
| **Connectors**            | • 4 BNC Analog composite video inputs, NTSC/PAL autosensing  
                           | • RJ-45 for Ethernet 10BaseT/100BaseTX  
                           | • 4 alarm inputs,  
                           | • 4 alarm outputs,  
<pre><code>                       | • RS-485 half duplex port                                                                                                                   |
</code></pre>
<table>
<thead>
<tr>
<th>Item</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processors and memory</td>
<td>• CPU: 4 x ETRAX 100LX 32bit</td>
</tr>
<tr>
<td></td>
<td>• Video processing and compression: 4 x ARTPEC-2</td>
</tr>
<tr>
<td></td>
<td>• RAM: 4 x 32 MB</td>
</tr>
<tr>
<td></td>
<td>• Flash: 4 x 8 MB</td>
</tr>
<tr>
<td></td>
<td>• Battery backed up real-time clock</td>
</tr>
<tr>
<td>Operating conditions</td>
<td>• 0º-45ºC (32-113 ºF)</td>
</tr>
<tr>
<td></td>
<td>• Humidity 20-80% RH (non-condensing)</td>
</tr>
<tr>
<td>Installation, management and maintenance</td>
<td>• AXIS Camera Management tool on CD and web-based configuration</td>
</tr>
<tr>
<td></td>
<td>• Configuration of backup and restore</td>
</tr>
<tr>
<td></td>
<td>• Firmware upgrades over HTTP or FTP, firmware available at <a href="http://www.axis.com">www.axis.com</a></td>
</tr>
<tr>
<td>Video access from web browser</td>
<td>• Camera live view for up to 20 clients (per video input)</td>
</tr>
<tr>
<td></td>
<td>• Video recording to file (ASF)</td>
</tr>
<tr>
<td></td>
<td>• Sequence tour for up to 20 PTZ presets</td>
</tr>
<tr>
<td></td>
<td>• Customizable HTML pages</td>
</tr>
<tr>
<td>Minimum Web browsing requirements</td>
<td>• Pentium III CPU 500 MHz or higher, or equivalent AMD</td>
</tr>
<tr>
<td></td>
<td>• 128 MB RAM, DirectX 9 compatible graphics board</td>
</tr>
<tr>
<td></td>
<td>• Direct Draw</td>
</tr>
<tr>
<td></td>
<td>• Windows XP, 2000, Vista</td>
</tr>
<tr>
<td></td>
<td>• Internet Explorer 6.x or later</td>
</tr>
<tr>
<td></td>
<td>For other operating systems and browsers see <a href="http://www.axis.com/techsup">www.axis.com/techsup</a></td>
</tr>
<tr>
<td>System integration support</td>
<td>• Open API for application integration, including the VAPIX® API*, AXIS Media Control SDK*, event trigger data in video stream</td>
</tr>
<tr>
<td></td>
<td>• Quality of Service (QoS) Layer 3, DiffServ Model</td>
</tr>
<tr>
<td></td>
<td>• Watchdog ensures continuous operation, event notifications can be monitored by other systems</td>
</tr>
<tr>
<td></td>
<td>• Embedded Linux operating system</td>
</tr>
<tr>
<td></td>
<td>* Available at <a href="http://www.axis.com">www.axis.com</a></td>
</tr>
<tr>
<td></td>
<td>*This product includes software developed by the Open SSL Project for use in the Open SSL Tool kit (<a href="http://www.openssl.org">www.openssl.org</a>)</td>
</tr>
<tr>
<td>Accessories included</td>
<td>• Installation Guide,</td>
</tr>
<tr>
<td></td>
<td>• CD with installation and management tools, software and User's Manual,</td>
</tr>
<tr>
<td></td>
<td>• MPEG-4 licenses (1 encoder, 1 decoder),</td>
</tr>
<tr>
<td></td>
<td>• MPEG-4 decoder (Windows)</td>
</tr>
<tr>
<td>Accessories not included</td>
<td>• AXIS 295 Video Surveillance Joystick</td>
</tr>
<tr>
<td></td>
<td>• Multi-user decoder license pack</td>
</tr>
<tr>
<td>Video management software (not included)</td>
<td>• AXIS Camera Station - Surveillance application for viewing, recording and archiving up to 25 cameras</td>
</tr>
<tr>
<td></td>
<td>See <a href="http://www.axis.com/partner/adp_partners.htm">www.axis.com/partner/adp_partners.htm</a> for further software applications from partners</td>
</tr>
<tr>
<td>Item</td>
<td>Specification</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------</td>
</tr>
<tr>
<td>Approvals</td>
<td>• EN 61000-6-1,</td>
</tr>
<tr>
<td></td>
<td>• EN 61000-6-2,</td>
</tr>
<tr>
<td></td>
<td>• EN 55024</td>
</tr>
<tr>
<td></td>
<td>• EN 55022 Class B</td>
</tr>
<tr>
<td></td>
<td>• EN 61000-3-2,</td>
</tr>
<tr>
<td></td>
<td>• EN 61000-3-3,</td>
</tr>
<tr>
<td></td>
<td>• FCC Part 15 Subpart B Class B,</td>
</tr>
<tr>
<td></td>
<td>• AS/NZS CISPR 22</td>
</tr>
<tr>
<td></td>
<td>• ICES-003</td>
</tr>
<tr>
<td></td>
<td>• VCCI Class B, ITE</td>
</tr>
<tr>
<td></td>
<td>• EN 60950-1</td>
</tr>
</tbody>
</table>

| Dimensions (HxWxD) and weight | • 30 x 130 x 255 mm (1.2" x 5.1" x 10.0") |
|                               | • 270g (0.6 lb.) |
General performance considerations
When setting up your system, it is important to consider how various settings and situations will affect performance. Some factors affect the amount of bandwidth (the bit rate) required, others can affect the frame rate, and some will affect both. If the load on the CPU reaches its maximum, this will also affect the frame rate.

The following factors are among the most important to consider:

- High image resolutions and/or lower compression levels result in larger images. Bandwidth affected.
- Access by large numbers of Motion JPEG and/or unicast MPEG-4 clients. Bandwidth affected.
- Simultaneous viewing of different streams (resolution, compression, etc.) by different clients. Frame rate and bandwidth affected.
- Accessing both Motion JPEG and MPEG-4 video streams simultaneously. Frame rate and bandwidth affected.
- Heavy usage of event settings affects the CPU load. Frame rate affected.
- Enabled motion detection. Frame rate and bandwidth affected.
- Heavy network utilization due to poor infrastructure. Bandwidth affected.
- Viewing on poorly performing client PC lowers perceived performance. Frame rate affected.

Optimizing your system
To see the bandwidth and frame rate currently required by the video stream, the AXIS 243Q Blade provides a tool that can be used to display these values directly in the video image.

To do this, special format strings are added as part of a text overlay. Simply add #r (average frame rate in fps) and/or #b (average bandwidth in Kbps) to the overlay.

For detailed instructions, please see the online help for Video & Image > Overlay Settings, and the help for File Naming & Date/Time Formats.

Important!
- The figures displayed here are the values as delivered by the server. If other restrictions are currently in force, (e.g. bandwidth limitation) these values might not correspond to those actually received by the client.
- For Motion JPEG, these values will only be accurate as long as no frame rate limit has been specified.
Bandwidth
As there are many factors affecting bandwidth, it is very difficult to predict the required amounts. The settings that affect bandwidth are:

- the image resolution
- the image compression
- the frame rate
- the MPEG-4 object type
- the MPEG-4 GOV structure
- the analog cameras connected to the video server

There are also factors in the monitored scene that will affect the bandwidth. These are:

- the amount of motion
- the image's complexity
- the lighting conditions

For MPEG-4, if there is only limited bandwidth available, and if this is more important than the image quality, using a constant bit rate (CBR) is recommended. Use a variable bit rate (VBR) if the image quality needs to be maintained at a higher level. If supported on the network, consider also using MPEG-4 multicasting, as the bandwidth consumption will be much lower.
**ActiveX** - ActiveX is a standard that enables software components to interact with one another in a networked environment, regardless of the language(s) used to create them. Web browsers may come into contact with ActiveX controls, ActiveX documents, and ActiveX scripts. ActiveX controls are often downloaded and installed automatically as required.

**AF (Autofocus)** - A system by which the camera lens automatically focuses on a selected part of the subject.

**AMC (AXIS Media Control)** - AMC is the ActiveX component required to view moving images from an Axis video device in Internet Explorer. The component is installed automatically on the viewing computer on first use. Once installed, AMC can be configured from Windows Control Panel.

**Analog video camera** - The signal from an analog video camera is viewed directly on e.g. a monitor in the analog system, which depends on traditional analog cabling. Alternatively, the signal can be digitized with the use of a video server, and can then be made available over a data (IP) network.

**Angle** - The field of view, relative to a standard lens in a 35mm still camera, expressed in degrees, e.g. 30°. For practical purposes, this is the area that a lens can cover, where the angle of view is determined by the focal length of the lens. A wide-angle lens has a short focal length and covers a wider angle of view than standard or telephoto lenses, which have longer focal lengths.

**API (Application Programming Interface)** - An API is a set of routines, protocols, and tools for building software applications. A good API makes it easier to develop a program by providing all the required building blocks. The Axis VAPIX API allows Axis products to be integrated into other applications.

**ARP (Address Resolution Protocol)** - This protocol is used to associate an IP address to a hardware MAC address. A request is broadcast on the local network to discover the MAC address for an IP address.

**ARTPEC (Axis Real Time Picture Encoder)** - A chip designed by Axis for image compression. ARTPEC supports a range of CCD and CMOS sensors, built-in functionality for sharpening, backlight compensation, noise reduction and white balance, support for multiple Motion-JPEG streams, support for MPEG-4 part 2, up to 30 frames/second from 4 simultaneous video sources and real-time compression of up to 45 Megapixels/second.

**ASIC (Application Specific Integrated Circuit)** - A circuit designed for a specific application, as opposed to a general purpose circuit, such as a microprocessor.

**Aspect ratio** - A ratio of width to height in images. A common aspect ratio used for television screens and computer monitors is 4:3. High-definition television (HDTV) uses an aspect ratio of 9:16.

**Autoiris (DC-Iris)** - This special type of iris is electrically controlled by the camera, to automatically regulate the amount of light allowed to enter.

**AVI (Audio Video Interleave)** - A video format that supports simultaneous playback of audio and video.

**AXIS Internet Dynamic DNS Service** - This free service provides an Axis network product with a unique DNS or domain name (URL address), which can then be used instead of an IP address to access the product from a web browser.

**AXIS IP Utility** - A tool for discovering and setting IP addresses for Axis network devices. AXIS IP Utility is supplied free of charge by Axis.

**AXIS Camera Management** - A powerful and efficient installation and management tool for Axis network video products. The tool can automatically find and set IP addresses, show connection status and manage firmware upgrades of multiple devices.

**Bitmap** - A bitmap is a data file representing a rectangular grid of pixels. It defines a display space and color for each pixel (or "bit") in the display space. This type of image is known as a "raster graphic." GIFs and JPEGs are examples of image file types that contain bitmaps. Because a bitmap uses this fixed raster method, it cannot easily be rescaled without losing definition. Conversely, a vector graphic image uses geometrical shapes to represent the image, and can thus be quickly rescaled.

**Bit rate** - The bit rate (in kbit/s or Mbit/s) is often referred to as speed, but actually defines the number of bits/time unit and not distance/time unit.

**Bonjour** - Also known as zero-configuration networking, Bonjour enables the automatic discovery of computers, devices, and services on IP networks. Bonjour allows devices to automatically discover each other without the need to enter IP addresses or configure DNS servers. Bonjour is developed by Apple Computer Inc.

**BOOTP (Bootstrap Protocol)** - A protocol that can automatically configure a network device (give it an IP address). BOOTP is the basis for a more advanced network management protocol, the Dynamic Host Configuration Protocol (DHCP).

**CCD (Charged Coupled Device)** - This light-sensitive image device used in many digital cameras is a large integrated circuit that contains hundreds of thousands of photo-sites (pixels) that convert light energy into electronic signals. Its size is measured diagonally and can be 1/4", 1/3", 1/2" or 2/3".

**CCTV (Closed Circuit Television)** - A CCTV system is a closed/private video system, usually constructed with coaxial cabling, and used within a single building/group.
of buildings. It is used to visually monitor the location for security or industrial purposes. Video from the CCTV system can be recorded and viewed on-site or remotely.

CCTV video camera - A traditional CCTV video camera is an analog camera, available in both monochrome (black and white) and color. Cameras can be set in fixed positions or placed on "Pan/Tilt/Zoom" devices, which allow the camera to be maneuvered. Using a zoom lens provides a closer view of the object being viewed. CCTV analog video cameras can be viewed over a computer network by using a video server.

CGI (Common Gateway Interface) - A specification for communication between a web server and other (CGI) programs. For example, a HTML page that contains a form might use a CGI program to process the form data once it is submitted.

CIF (Common Intermediate Format) - CIF refers to the analog video resolutions 352x288 pixels (PAL) and 352x240 pixels (NTSC). See also Resolution.

Client-server - Client-server describes the relationship between two computer programs in which one program, the client, makes a service request from another program, the server, which fulfills the request. Typically, multiple client programs share the services of a common server program. A web browser is a client program that requests services (the sending of web pages or files) from a web server.

CMOS (Complementary Metal Oxide Semiconductor) - A CMOS is a widely used type of semiconductor that uses both negative and positive circuits. Since only one of the circuit types is on at any given time, CMOS chips require less power than chips using just one type of transistor. CMOS image sensors also allow processing circuits to be included on the same chip, an advantage not possible with CCD sensors, which are also much more expensive to produce.

Coaxial cable - Coaxial cable is the standard means of transmitting analog video in a CCTV system. Coaxial is also used by cable companies to distribute television in residential buildings.

Codec - In communications engineering, a codec is usually a coder/decoder. Codecs are used in integrated circuits or chips that convert e.g. analog video and audio signals into a digital format for transmission. The codec also converts received digital signals back into analog format. A codec uses analog-to-digital conversion and digital-to-analog conversion in the same chip.

Codec can also mean compression/decompression, in which case it is generally taken to mean an algorithm or computer program for reducing the size of large files and programs.

Composite video - A type of video signal in which the red, blue and green signals (sometimes audio signals too) are mixed together.

Compression - See Image compression.

Contrast - Defines the degree of difference between the lightest and darkest parts of an image or video stream.

Control unit - If a CCTV system has more than one camera, there must be a way to control the video signals going to recorders and monitors. There are three basic types of Video Control Unit: Multiplexer, Switch and Quad.

dB (Decibels) - A unit to measure sound level changes. A 3dB change is the smallest level change we can hear. A 3dB change is actually twice or half the audio power level. A gain of 0dB will leave the signal level unchanged.

DC-Iris - This special type of iris is electrically controlled by the camera, to automatically regulate the amount of light allowed to enter.

Decoder - See Video decoder.

De-interlacing - See Interlacing.

DHCP (Dynamic Host Configuration Protocol) - DHCP is a protocol that lets network administrators automate and centrally manage the assignment of Internet Protocol (IP) addresses to network devices in a network.

DHCP uses the concept of a "lease" or amount of time that a given IP address will be valid for a computer. The lease time can vary, depending on how long a user is likely to require the network connection at a particular location.

DHCP also supports static addresses for e.g. computers running web servers, which need a permanent IP address.

DNS (Domain Name System) - DNS is used to locate and translate Internet domain names into IP (Internet Protocol) addresses. A domain name is a meaningful and easy-to-remember name for an Internet address. For example the domain name www.example.com is much easier to remember than 192.0.34.166. The translation tables for domain names are contained in Domain name servers.

Domain server - Domains can also be used by organizations that wish to centralize the management of their (Windows) computers. Each user within a domain has an account that usually allows them to log in to and use any computer in the domain, although restrictions may also apply. The domain server is the server that authenticates the users on the network.

Dome network camera - A remotely controllable camera mounted in a special housing, characterized by the dome shaped glass or plastic covering behind which the camera resides. Usually mounted on a ceiling and looking downwards, a dome camera can often rotate up to 360 degrees, thus providing excellent coverage of large areas.

Duplex - See Full-duplex.

DVD (Digital Versatile Disc) - An optic disc with the same
physical size as a CD, but with significantly greater storage capacity.

DVR (Digital Video Recorder) - A DVR records analog video to a hard disk in digital format. Most DVRs use the MPEG-2 format for encoding analog video signals.

Encoder - See Video encoder.

Ethernet - Ethernet is the most widely installed local area network technology. An Ethernet LAN typically uses special grades of twisted pair wires. The most commonly installed Ethernet systems are 10BASE-T and 100BASE-T10, which provide transmission speeds up to 10 Mbps and 100 Mbps respectively.

ETRAX (Ethernet Token Ring AXIS) - The ETRAX chip is the cornerstone of Axis technology and the ‘brain’ in nearly all Axis products. A multipurpose Linux chip with integrated Ethernet networking and extremely flexible I/O options.

Factory default settings - These are the settings that originally applied for a device when it was first delivered from the factory. If it should become necessary to reset a device to its factory default settings, this will, for many devices, completely reset any settings that were changed by the user.

Firewall - A firewall works as a barrier between networks, e.g. between a Local Area Network and the Internet. The firewall ensures that only authorized users are allowed to access the one network from the other. A firewall can be software running on a computer, or it can be a standalone hardware device.

Fixed iris - See Autoiris.

Focal length - Measured in millimeters, the focal length of a camera lens determines the width of the horizontal field of view, which in turn is measured in degrees.

FTP (File Transfer Protocol) - FTP is an application protocol that uses the TCP/IP protocols, used to exchange files between computers/devices on networks.

Frame - A frame is a complete video image. In the 2:1 interlaced scanning format of the RS-170 and CCIR formats, a frame is made up of two separate fields of 262.5 or 312.5 lines interlaced at 60 or 50 Hz to form a complete frame, which appears at 30 or 25 Hz. In video cameras with a progressive scan, each frame is scanned line-by-line and not interlaced; most are also displayed at 30 and 25 Hz.

Frame rate - The frame rate used to describe the frequency at which a video stream is updated is measured in frames per second (fps). A higher frame rate is advantageous when there is movement in the video stream, as it maintains image quality throughout.

Full-duplex - Transmission of data in two directions simultaneously. In an audio system this would describe e.g. a telephone systems. Half-duplex also provides bi-directional communication, but only in one direction at a time, as in a walkie-talkie system. See also Simplex.

G.711 - The international standard for encoding telephone audio on a 64 kbps channel. It is a pulse code modulation (PCM) scheme operating at 8 kHz sample rate.

G.726 - A frequently used speech-compression algorithm in telecommunications due to its high perceived speech quality and low resource requirements.

Gain - Gain is the amplification factor and the extent to which an analog amplifier boosts the strength of a signal. Amplification factors are usually expressed in terms of power. The decibel (dB) is the most common way of quantifying the gain of an amplifier.

Gateway - A gateway is a point in a network that acts as an entry point to another network. In a corporate network for example, a computer server acting as a gateway often also acts as a proxy server and a firewall server. A gateway is often associated with both a router, which knows where to direct a given packet of data that arrives at the gateway, and a switch, which furnishes the actual path in and out of the gateway for a given packet.

GIF (Graphics Interchange Format) - GIF is one of the most common file formats used for images in web pages. There are two versions of the format, 87a and 89a. Version 89a supports animations, i.e. a short sequence of images within a single GIF file. A GIF89a can also be specified for interlaced presentation.

GOV (Group Of VOPs) - A group of VOPs is the basic unit of an MPEG-4 video stream. The GOV contains different types and numbers of VOPs (I-VOPs, P-VOPs) as determined by the GOV length and GOV structure. See also VOP.

GOV length - The GOV length determines the number of images (VOPs) in the GOV structure. See also GOV and VOP.

GOV structure - The GOV structure describes the composition of an MPEG-4 video stream, as regards the type of images (I-VOPs or P-VOPs) included in the stream, and their internal order. See also GOV and VOP.

HTML (Hypertext Markup Language) - HTML is the set of “markup” symbols or codes inserted in a file intended for display in web browser. The markup tells the browser how to display the page’s words and images for the user.

HTTP (Hypertext Transfer Protocol) - HTTP is the set of rules for exchanging files (text, graphic images, sound, video, and other multimedia files) on the web. The HTTP protocol runs on top of the TCP/IP suite of protocols.

HTTPS (Hypertext Transfer Protocol over SSL) - HTTPS is a protocol used by web browsers and servers to encrypt and decrypt user page requests and the pages returned by the server. The encrypted exchange of information is governed by the use of an HTTPS certificate (issued by a Certificate Authority), which guarantees the authenticity.
of the server.

**Hub** - A (network) hub is used to connect multiple devices to the network. The hub transmits all data to all devices connected to it, whereas a switch will only transmit the data to the device it is specifically intended for.

**IEEE 802.11** - A family of standards for wireless LANs. The 802.11a standard supports 1 or 2 Mbit/s transmission on the 5 GHz band. IEEE 802.11b supports data rates up to 11 Mbit/s on the 2.4 GHz band, while 802.11g allows up to 54 Mbit/s on the 2.4 GHz band.

**Image compression** - Image compression minimizes the file size (in bytes) of an image. Two of the most common compressed image formats are JPEG and GIF. See also **MPEG** and **Motion JPEG**.

**Interlacing** - Interlaced video is video captured at 50 pictures (known as fields) per second, of which every 2 consecutive fields (at half height) are then combined into 1 frame. Interlacing was developed many years ago for the analog TV world and is still used widely today. It provides good results when viewing motion in standard TV pictures, although there is always some degree of distortion in the image.

To view interlaced video on e.g. a computer monitor, the video must first be de-interlaced, to produce progressive video, which consists of complete images, one after the other, at 25 frames per second. See also **Progressive scan**.

**IP (Internet Protocol)** - The Internet Protocol is a method transmitting data over a network. Data to be sent is divided into individual and completely independent "packets." Each computer (or host) on the Internet has at least one address that uniquely identifies it from all others, and each data packet contains both the sender's address and the receiver's address.

The Internet Protocol ensures that the data packets all arrive at the intended address. As IP is a connectionless protocol, which means that there is no established connection between the communication end-points, packets can be sent via different routes and do not need to arrive at the destination in the correct order.

Once the data packets have arrived at the correct destination, another protocol - **Transmission Control Protocol (TCP)** - puts them in the right order. See also **TCP**.

**IP address** - An IP address is simply an address on an IP network used by a computer/device connected to that network. IP addresses allow all the connected computers/devices to find each other and to pass data back and forth.

To avoid conflicts, each IP address on any given network must be unique. An IP address can be assigned as fixed, so that it does not change, or it can be assigned dynamically (and automatically) by **DHCP**.

An IP address consists of four groups (or quads) of decimal digits separated by periods, e.g. 130.5.5.25. Different parts of the address represent different things. Some part will represent the network number or address, and some other part will represent the local machine address. See also **IP (Internet Protocol)**.

**Inputs/Outputs (I/Os)** - The digital I/Os on, for example, a network camera can be used to connect any device that can toggle between an open and a closed circuit.

For example, if a door switch is used as an input device, opening the door could trigger the upload of video images and the sending of notification messages.

An output might, for example, be used to automatically start a siren when there is a motion detection trigger.

**ISMAs goal** is: "To accelerate the adoption and deployment of open standards for streaming rich media content such as video, audio, and associated data, over Internet protocols."

**I-VOP** - See **VOP**.

**JPEG (Joint Photographic Experts Group)** - Together with the GIF file format, JPEG is an image file type commonly used on the web. A JPEG image is a bitmap, and usually has the file suffix '.jpg' or '.jpeg.' When creating a JPEG image, it is possible to configure the level of compression to use. As the lowest compression (i.e. the highest quality) results in the largest file, there is a trade-off between image quality and file size.

**kbit/s (kilobits per second)** - A measure of the bit rate, i.e. the rate at which bits are passing a given point. See also **Bit rate**.

**LAN (Local Area Network)** - A LAN is a group of computers and associated devices that typically share common resources within a limited geographical area.

**Linux** - Linux is an open source operating system within the UNIX family. Because of its robustness and availability, Linux has won popularity in the open source community and among commercial application developers.

**Lux** - A standard unit of illumination measurement.

**MAC address (Media Access Control address)** - A MAC address is a unique identifier associated with a piece of networking equipment, or more specifically, its interface with the network. For example, the network card in a computer has its own MAC address.

**Manual iris** - This is the opposite of an autoiris, i.e. the camera iris must be adjusted manually to regulate the amount of light allowed to reach the image sensor.

**Mbit/s (Megabits per second)** - A measure of the bit rate, i.e. the rate at which bits are passing a given point. Commonly used to give the "speed" of a network. A LAN might run at 10 or 100 Mbit/s. See also **Bit rate**.

**Monitor** - A monitor is very similar to a television set, but
lacks the electronics to pick up regular television signals.

**Motion JPEG** - Motion JPEG is a simple compression/decompression technique for network video. Latency is low and image quality is guaranteed, regardless of movement or complexity of the image. Image quality is controlled by adjusting the compression level, which in turn provides control over the file size, and thereby the bit rate.

High-quality individual images from the Motion JPEG stream are easily extracted. See also JPEG and GIF.

**Megapixel** - See Pixel.

**MPEG (Moving Picture Experts Group)** - The Moving Picture Experts Group develops standards for digital video and audio compression. It operates under the auspices of the International Organization for Standardization (ISO). The MPEG standards are an evolving series, each designed for a different purpose.

**MPEG-2** - The designation for a group of audio and video coding standards, and is typically used to encode audio and video for broadcast signals, including digital satellite and Cable TV. MPEG-2, with some modifications, is also the coding format used by standard commercial DVD movies.

**MPEG-4** - MPEG-4 is a group of audio and video coding standards and related technology. The primary uses for the MPEG-4 standard are web (streaming media) and CD distribution, conversational (videophone), and broadcast television.

Most of the features included in MPEG-4 are left to individual developers to decide whether to implement them or not. This means that there are probably no complete implementations of the entire MPEG-4 set of standards. To deal with this, the standard includes the concept of "profiles" and "levels", allowing a specific set of capabilities to be defined in a manner appropriate for a subset of applications.

**Multicast** - Bandwidth-conserving technology that reduces bandwidth usage by simultaneously delivering a single stream of information to multiple network recipients. See also Unicast.

**Multiplexer** - A multiplexer is a high-speed switch that provides full-screen images from up to 16 analog cameras. Multiplexers can playback everything that happened on any one camera with no interference from the other cameras on the system.

**Network camera (Network video camera)** - A network camera is a camera and computer combined in one intelligent unit. It captures and sends live video directly over an IP network such as a LAN, intranet or the Internet. Users can view and/or manage the camera using a standard web browser or application software from any local or remote computer on a network. The camera allows multiple authorized viewers from different locations to simultaneously access images. A network camera is sometimes known as an IP camera.

**Network connectivity** - The physical (wired or wireless) and logical (protocol) connection of a computer network or an individual device to a network, such as the Internet or a LAN.

**Network video** - Network video (often referred to as IP-Surveillance for specific applications within security surveillance and remote monitoring) is a system that gives users the ability to monitor and record video over an IP network (LAN/WAN/Internet).

**NTSC (National Television System Committee)** - NTSC is an analog color encoding system used in television systems in Japan, the United States and other parts of the Americas. NTSC defines the video signal using 525 TV lines per frame, at a refresh rate equal to 30 frames per second. See also PAL.

**NVR (Network Video Recorder)** - A dedicated Network Video Recorder (NVR) can be used to gather data streams from remote network cameras and video servers and store them on a hard disk. An NVR can be a standard networked PC, or a dedicated video recording hard disk server with its own software application.

**PAL (Phase Alternating Line)** - PAL is an analog color encoding system used in television systems in Europe and in many other parts of the world. PAL defines the video signal using 625 TV lines per frame, at a refresh rate equal to 25 frames per second. See also NTSC.

**PEM (Privacy Enhanced Mail)** - An early standard for securing electronic mail. The PEM-format is often used for representing an HTTPS certificate or certificate request.

**Ping** - Ping is a basic network program used diagnostically to check the status of a network host or device. Ping can be used to see if a particular network address (IP address or host name) is occupied or not, or if the host at that address is responding normally. Ping can be run from e.g. the Windows Command prompt or the command line in Unix.

**Pixel (Picture Element)** - A pixel is one of the many tiny dots that make up a digital image. The color and intensity of each pixel represents a tiny area of the complete image.

**PoE (Power over Ethernet)** - Power over Ethernet provides power to a network device via the same cable as used for the network connection. This is very useful for IP-Surveillance and remote monitoring applications in places where it may be too impractical or expensive to power the device from a power outlet.

**PPP (Point-to-Point Protocol)** - A protocol that uses a serial interface for communication between two network devices. For example, a PC connected by a phone line to a server.

**PPTP (Point-to-Point Tunneling Protocol)** - A protocol
(set of communication rules) that allows corporations to extend their own corporate network through private "tunnels" over the public Internet. In this way a corporation can effectively use a WAN (Wide Area Network) as a large single LAN (Local Area Network). This kind of interconnection is known as a virtual private network (VPN).

**Pre/post alarm images** - The images from immediately before and after an alarm. These images are stored in a buffer for later retrieval.

**Progressive scan** - Progressive scan, as opposed to interlaced video, scans the entire picture, line by line every sixteenth of a second. In other words, captured images are not split into separate fields as in interlaced scanning.

Computer monitors do not need interlace to show the picture on the screen, but instead show them progressively, on one line at a time in perfect order i.e. 1, 2, 3, 4, 5, 6, 7 etc., so there is virtually no “flickering” effect. In a surveillance application, this can be critical when viewing detail within a moving image, such as a person running. A high-quality monitor is required to get the best from progressive scan. See also Interlacing.

**Protocol** - A special set of rules governing how two entities will communicate. Protocols are found at many levels of communication, and there are hardware protocols and software protocols.

**Proxy server** - In an enterprise that uses the Internet, a proxy server acts as an intermediary between a workstation user and the Internet. This provides security, administrative control, and a caching service. Any proxy server associated with a gateway server, or part of a gateway server, effectively separates the enterprise network from the outside network and the local firewall. It is the firewall server that protects the enterprise network from outside intrusion.

**PTZ (Pan Tilt Zoom)** - A PTZ-enabled camera can be remotely controlled so as to change the view from the camera. Panning is the movement of the camera along its horizontal axis, tilting is the movement of the camera along its vertical axis, and zooming is the adjustment of the zoom lens to magnify the view.

**P-VOP** - See VOP.

**Resolution** - Image resolution is a measure of how much detail a digital image can hold: the greater the resolution, the greater the level of detail. Resolution can be specified as the number of pixel-columns (width) by the number of pixel-rows (height), e.g. 320x240. Alternatively, the total number of pixels (usually in megapixels) in the image can be used. In analog systems it is also common to use other format designations, such as CIF, QCIF, 4CIF, etc.

**RS-232** - A long-established standard that describes the physical interface and protocol for low-speed serial data communication between devices. This is the interface that e.g. a computer uses to talk to and exchange data with a modem and other serial devices.

**RS-485** - An upgraded version of RS-422 that supports up to 32 devices on the same connection. RS-485 is an electrical specification of a two-wire, half-duplex, multipoint serial connection. It enables the configuration of inexpensive local networks and multidrop communications links. It offers high data transmission speeds (up to 10Mbit/s), and as it uses a differential balanced line over twisted pair (like RS-422), it can span relatively large distances (4000 feet or 1200 meters). RS-485 only specifies the electrical characteristics of the driver and the receiver. It does not specify or recommend any data protocol.

**RTCP (Real-Time Control Protocol)** - RTCP provides support for real-time conferencing of groups of any size within an intranet. This support includes source identification and support for gateways like audio and video bridges as well as multicast-to-unicast translators. It offers quality-of-service feedback from receivers to the multicast group as well as support for the synchronization of different media streams.

**RTP (Real-Time Transport Protocol)** - An Internet protocol for the transport of real-time data, e.g. audio and video. It can be used for media-on-demand as well as interactive services such as Internet telephony.

**RTSP (Real Time Streaming Protocol)** - A control protocol, and a starting point for negotiating transports such as RTP, multicast and Unicast, and for negotiating codecs. RTSP can be considered a “remote control” for controlling the media stream delivered by a media server. RTSP servers typically use RTP as the protocol for the actual transport of audio/video data.

**Router** - A device that determines the next network point to which a packet should be forwarded on its way to its final destination. A router creates and/or maintains a special routing table that stores information on how best to reach certain destinations. A router is sometimes included as part of a network switch. See also Switch.

**Security surveillance** - Network video’s advanced functionality makes it highly suited to the applications involved in security surveillance. The flexibility of digital technology enhances security personnel’s ability to protect people, property and assets. Such systems are therefore an especially attractive option for companies currently using CCTV.

**Server** - In general, a server is a computer program that provides services to other computer programs in the same or other computers. A computer running a server program is also frequently referred to as a server. In practice, the server may contain any number of server and client programs. A web server is the computer program that
Supplies the requested HTML pages or files to the client (web browser).

**Simplex** - In simplex operation, a network cable or communications channel can only send information in one direction. See also Full-duplex.

**SMTP (Simple Mail Transfer Protocol)** - Used for sending and receiving e-mail. However, as it is "simple," it is limited in its ability to queue messages at the receiving end, and is usually used with one of two other protocols, POP3 or IMAP. These other protocols allow the user to save messages in a server mailbox and download them periodically from the server.

**SMTP authentication** - An extension of SMTP, where the client is required to log into the mail server before or during the sending of email. It can be used to allow legitimate users to send email while denying the service to unauthorized users, such as spammers.

**SNMP (Simple Network Management Protocol)** - SNMP forms part of the Internet Protocol suite, as defined by the Internet Engineering Task Force. The protocol can support monitoring of network-attached devices for any conditions that warrant administrative attention.

**Sockets** - Sockets are a method for communication between a client program and a server program over a network. A socket is defined as "the endpoint in a connection." Sockets are created and used with a set of programming requests or "function calls" sometimes called the sockets application programming interface (API).

**SSL/TSL (Secure Socket Layer/Transport Layer Security)** - These two protocols (SSL is succeeded by TSL) are cryptographic protocols that provide secure communication on a network. SSL is commonly used over HTTP to form HTTPS, as used e.g. on the Internet for electronic financial transactions. SSL uses public key certificates to verify the identity of the server.

**Subnet & subnet mask** - A subnet is an identifiable separate part of an organization's network. Typically, a subnet may represent all the machines at one geographic location, in one building, or on the same local area network (LAN). Having an organization’s network divided into subnets allows it to be connected to the Internet with a single shared network address.

The subnet mask is the part of the IP address that tells a network router how to find the subnet that the data packet should be delivered to. Using a subnet mask saves the router having to handle the entire 32-bit IP address; it simply looks at the bits selected by the mask.

**Switch** - A network device that connects network segments together, and which selects a path for sending a unit of data to its next destination. In general, a switch is a simpler and faster mechanism than a router, which requires knowledge about the network and how to determine the route. Some switches include the router function. See also **Router**.

**TCP (Transmission Control Protocol)** - TCP is used along with the Internet Protocol (IP) to transmit data as packets between computers over the network. While IP takes care of the actual packet delivery, TCP keeps track of the individual packets that the communication (e.g. requested a web page file) is divided into, and, when all packets have arrived at their destination, it reassembles them to re-form the complete file.

TCP is a connection-oriented protocol, which means that a connection is established between the two end-points and is maintained until the data has been successfully exchanged between the communicating applications.

The advantages in using this particular mode of recording.

**UDP (User Datagram Protocol)** - UDP is a communications protocol that offers limited service for exchanging data in a network that uses the Internet Protocol (IP). UDP is an alternative to the Transmission Control Protocol (TCP). The advantage of UDP is that it is not required to deliver all data and may drop network packets when there is e.g. network congestion. This is suitable for live video, as there is no point in re-transmitting old information that will not be displayed anyway.

**Unicast** - Communication between a single sender and a single receiver over a network. A new connection is established for each new user. See also Multicast.

**UPnP™** - A set of computer network protocols that allows the automatic peer-to-peer detection of devices on the network. UPnP is promoted by the UPnP Forum.

**URL (Uniform Resource Locator)** - An "address" on the network.

**Video camera** - See Network camera and CCTV video camera.

**Video encoder (video server)** - A video encoder/server digitizes analog video signals and sends digital images directly over an IP network, such as a LAN, intranet or the Internet. In effect, it turns an analog video system into a network video system and enables users to view live images using a web browser or application software on any local or remote computer on a network.

**Video management software** - Video management software supplies the means for monitoring, analyzing and recording network video. In its simplest form, it offers live viewing, storage and retrieval of video sequences. Advanced applications may also provide support for recording of live video from multiple devices, different recording modes, search functions, remote access via a web browser, control of PTZ devices, etc.

**VMD (Video Motion Detection)** - Video Motion detection defines activity (motion) in a monitored scene by
analyzing image data and differences in series of images. This detection can, for example, be used to trigger an alarm event in a network camera and start the upload of images from the camera.

**Video switcher** - An analog video switcher sequentially displays full screen images, from one camera after another, typically at 3-5 seconds intervals. Other camera sources are not recorded while the image source from one

**VOP (Video Object Plane)** - A VOP is an image frame in an MPEG-4 video stream. There are several types of VOP:
- An I-VOP is a complete image frame.
- An P-VOP codes the differences between images, as long as it is more efficient to do so. Otherwise it codes the whole image, which may also be a completely new image.

**Web camera (Webcam)** - A camera that requires a constant connection (via e.g. USB) to a PC for its operation. See also **Network camera**.

**Web server** - A program that allows web browsers to retrieve files from computers connected to the Internet. The Web server listens for requests from browsers and upon receiving a request for a file sends it back to the browser. The primary function of a Web server is to serve pages to other remote computers.

**Zoom lens** - A zoom lens can be moved (zoomed) to enlarge the view of an object to show more detail.
Index

A
Access from a browser 9
Accessing the Setup tools 16
Action buttons 24
Active/Inactive 24
Administrators 16, 38
Advanced Simple Profile 12
Advanced TCP/IP settings 43
Alarm 32, 36, 50
Allowed IP addresses 38
AMC Viewer Toolbar 11
Anonymous viewers 38
ARP/Ping 42
AXIS Internet Dynamic DNS Service 42
AXIS Media Control (AMC) 9, 14

B
Backup 47
Bandwidth 12, 61
Basic TCP/IP settings 42
Bit Rate 12
bit rate 12
Bonjour 46
Buffers 33

C
Camera tampering 35
CGI links 24, 28
Click-in-image 28
COM Port RS-485 52
Constant Bit Rate 12
Control button 8

D
Date & Time 41
DC power 50
DC-Iris 62
default button 47
Default video format 24
Default Viewer 23
Digital input 50
DIP switch 7
DNS configuration 43
DNS server 43
Domain Name 43
Domain name 43

E
Email server 45
Emergency recovery 54
Enable ARP/Ping 42
Event servers 32
Event types 32

F
Factory default settings 49
firmware 2
Frame rates 18, 61
FTP Server 32

G
Generic HTTP 52
Generic TCP/IP 52

H
half duplex 57
Host name 43
HTTP API 28
HTTP API requests 24
HTTP port number 44
HTTP Server 32
HTTPS 39

I
I/O Ports 46
I/O Terminal connector 50
Installing PTZ devices 25
IP address filtering 38

L
Live view config 23
M
Motion detection 36
Motion JPEG 12
MPEG-4 12
MPEG-4 protocols 13
MPEG-4 settings 46
Multicasting 13

N
Network settings 42
Network traffic 44
NTP Server 41
NTP server 43

O
Operator 38
Other MPEG-4 Clients 15
Output buttons 24
Overlays 18
Overview 6

P
Pan/Tilt/Zoom 27, 52
password 10
Pinout – I/O connectors 50
Port status 37
Ports & Devices 46
Post-trigger buffer 33
Preset positions 29
Pre-trigger buffer 33
PTZ commands 24, 28
PTZ control queue 30
Pulse 24
Pulse button 24

Q
QoS 45
Quad stream 22

R
Recovery 54
Referrals 38
Relative and absolute PTZ drivers 27
Restart 47
Restore 47
RS-485 50
RTP 13, 46
RTSP 13, 44

S
Security 38
Serial number 54
serial number 54
server time 41
Services 42
Simple Profile 12
SMTP settings 45
Snapshot Button 11
SOCKS server 45
Specifications 57
Streaming MPEG-4 13
Support 47
System options 38

T
TCP Server 32
TCP/IP settings 42
Trigger buttons 10
Troubleshooting 53

U
UDP 13
Unicasting 13
Upgrade Server 47
UPnP 46
User-defined links 24
Users 38

V
Variable Bit Rate 12
Video input 8
Video source 19
Video streams 12, 14, 18
Viewer settings 23